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	 หนัังสืือสืถิิติิขั้ั�นัสืูงสืำหรัับการัวิิจััยทางพฤติิกรัรัมศาสืติรั์และสืังคมศาสืติรั์	มีวัิติถิุปรัะสืงค์เพื�อยกรัะดัับการัใช้้
สืถิิติิสืำหรัับการัวิิจััยเพื�อพัฒนัาสืมรัรัถินัะการัทำวิิจััยขั้องขั้องนัักศึกษาในัรัะดัับบัณฑิิติศึกษา	รัวิมทั�งนัักวิิจััยทาง
พฤติิกรัรัมศาสืติรั์	ซึึนัักวิิจััยมักใช้้สืถิิติิขั้ั�นัสืูงเป็นัเครัื�องมือสืำคัญในัการัเป็นัสื่วินัหนัึ�งขั้องการัออกแบบงานัวิิจััยไดั้
หลากหลายและติอบคำถิามวิิจััยไดั้ติรังกับควิามติ้องการัขั้องตินัเองมากขั้ึ�นั	แต่ิจัากปรัะสืบการัณ์พบวิ่านัักวิิจััย
จัำนัวินัมากยังมีปัญหาในัการันัำสืถิิติิไปใช้้ในัการัติอบคำถิามวิิจััยขั้องตินัเองไม่ถิูกติ้อง	รัวิมทั�งการัแปลควิามหมาย
จัากผลการัวิิเครัาะห์	นัอกจัากนัี�ปัญหาสืำคัญหนัึ�งคือการัใช้้โปรัแกรัมการัวิิเครัาะห์ที�มีปรัะสิืทธิิภาพมักสืุ่มเสืี�ยง
ปัญหาลิขั้สิืทธิิ�ขั้องโปรัแกรัม	ด้ัวิยเหตุิผลดัังกล่าวิจึังได้ัเขั้ียนัหนัังสืือนัี�ขั้ึ�นัมาโดัยใช้้โปรัแกรัม	R	ซึึ�งเป็นัโปรัแกรัมไม่มี
ลิขั้สืิทธิิ�	แติ่มีปรัะสิืทธิิภาพสืูงในัการัวิิเครัาะห์ขั้้อมูลเมื�อใช้้สืถิิติิขัั้�นัสืูง	ผู้เขั้ียนัจึังหวิังว่ิาหนัังสืือนัี�จัะเป็นัสื่วินัหนัึ�งที�ช้่วิย
ยกรัะดัับนัักวิิจััยภาพการัทำวิิจััยทางรััฐปรัะศาสืนัศาสืติรั์	และการัปรัะยุกต์ิใช้้ในัศาสืติรั์อื�นัไดั้มีปรัะสืิทธิิภาพมากขั้ึ�นั
	 ผู้เขั้ียนัขั้อขั้อบคุณผู้ทรังคุณวุิฒิที�ใช้้ให้คำแนัะนัำที�ดัีและเป็นักัลยาณมิติรัผ่านักรัะบวินัการั	double-blind
peer	review	และขั้อบคุณเป็นัพิเศษสืำหรัับคณะวิิทยาการัจัดััการัที�สืนัับสืนัุนั
	 คุณค่าใดั	ๆ	ที�เกิดัจัากหนัังสืือเล่มนัี�	ผู้เขั้ียนัขั้อมอบแด่ัอาจัารัย์ทุกท่านัที�มีส่ืวินัปรัะสืิทธิิ�ปรัะสืาทควิามรัู้ทางสืถิิติิ
สืำหรัับการัวิิจััยต่ิอผู้เขั้ียนั	โดัยเฉพาะคณาจัารัย์สืถิาบันัวิิจััยพฤติิกรัรัมศาสืติรั์ปรัะยุกต์ิ	มหาวิิทยาลัยศรัีนัครัินัทรัวิิโรัฒ
อันัเป็นัสืถิานัที�บ่มเพาะผู้เขั้ียนัทางด้ัานัสืถิิติิสืำหรัับการัวิิจััย	สื่วินัควิามผิดัพลาดัใดั	ๆ	ที�เกิดัขั้ึ�นัในัหนัังสืือเล่มนัี�ผูเ้ขั้ียนั
นั้อมรัับแติ่เพียงผู้เดัียวิ
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)91ม(01
	 ในัช้่วิงไม่กี�ทศวิรัรัษที�ผ่านัมาไดั้มีการันัำเสืนัอเทคนัิคการัวิิเครัาะห์ขั้ั�นัสืูงที�จัุดัเนั้นัรั่วิมกันัคือการัวิิเครัาะห์
พหุติัวิแปรั	(multivariate	analysis)	และมีวิิวิัฒนัาการัอย่างติ่อเนัื�องขั้องวิิธีิการัทางสืถิิติิแบบ	“ดัั�งเดัิม”	เช้่นั	การั
ถิดัถิอยพหุคูณ	การัวิิเครัาะห์ควิามแปรัปรัวินั/การัวิิเครัาะห์องค์ปรัะกอบเช้ิงสืำรัวิจั	เทคนิัคทางสืถิิติิแหล่านัี�ไดั้รัับ
การัขั้ยายให้มีขีั้ดัควิามสืามารัถิในัการัปรัะยุกติ์ใช้้มากขั้ึ�นั	เช้่นั	โมเดัลพหุรัะดัับและเทคนัิคการัอนัุมานัเช้ิงสืาเหติุ
วิิธิีการัเหล่านัี�ไดั้รัับการัเสืรัิมดั้วิยโมเดัลทางสืถิิติิใหม่ที�แสืดังดั้วิยการัสืรั้างโมเดัลสืมการัเช้ิงโครังสืรั้างฐานัควิาม
แปรัปรัวินัรั่วิม	(covarianc	based	SEM)	หรัือฐานัควิามแปรัปรัวินั	(PLS-SEM)	ซึึ�งเป็นัวิิธิีการัผสืานัวิิธิีการัก่อนัหนั้านัี�
หลาย	ๆ	วิิธีิ	เช้่นั	การัถิดัถิอยเช้ิงพหุคูณ	การัวิิเครัาะห์เสื้นัทาง	และการัวิิเครัาะห์องค์ปรัะกอบเช้ิงสืำรัวิจัเขั้้ากับเทคนิัค
การัวิิเครัาะห์ใหม่	ๆ	ทำให้ไดั้เทคนิัคการัวิิเครัาะห์ที�ปรัะยุก์ใช้้ได้ัอย่างหลากหลายมากขั้ึ�นั	ผลคือทำให้ไดั้เทคนิัคใหม่	ๆ
ที�ลดัขั้้อจัำกัดัขั้องเทคนัิคแบบดัั�งเดัิมที�เคยมีมา
	 การัพัฒนัาวิิธิีการัวิิเครัาะห์ขั้ั�นัสืูงเหล่านัี�ไดั้รัับการัสืนัุบสืนัุนัอย่างมากจัากพลังการัปรัะมวิลผลที�เพิ�มขั้ึ�นั
อย่างมาก	ซึึ�งมีอยู่ในัรัูปแบบและแพลติฟัอรั์มติ่าง	ๆ	มากมายในัปัจัจัุบันั	ควิามพรั้อมใช้้งานัขั้องเทคนัิคเหล่านัี�ยัง
ขั้ยายตัิวิออกไปไม่เพียงแค่ผ่านัการัพัฒนัาอย่างติ่อเนัื�องขั้องแพ็คเกจัซึอฟัต์ิแวิรั์แบบดัั�งเดัิม	เช้่นั	SAS	และ	JMP,
IBM	SPSS	และ	STATA		ซึึ�งเป็นัซึอฟัติ์แวิรั์ที�ไดั้รัับควิามนัิยม	MPlus	สืำหรัับ	SEM		รัวิมถิึง	SmartPLS	และ
ADANCO	สืำหรัับ	PLS-SEM	นัอกจัากนัี�ยังมีซึอฟัติ์แวิรั์โอเพนัซึอรั์สืฟัรัีที�แพรั่หลายในัปัจัจัุบันั	ไดั้แก่		R	project
ซึึ�งมีมาติั�งแติ่ปี	1992	และไดั้รัับพัฒนัาให้ใช้้งานัง่ายขั้ึ�นัในัแพลติฟัอรั์ม		RStudio	ดัังนัั�นั	ปัจัจัุบันั	นัักวิิจััยมีทาง
เลือกซึอฟัต์ิแวิรั์ที�หลากหลายที�สืุดัเท่าที�มีมา
	 สืำหรัับหนัังสืือเล่มนัี�เขั้ียนัขั้ึ�นัโดัยมีควิามเช้ื�อมโยงกับรัายวิิช้าการัวิิเครัาะห์ขั้้อมูลขัั้�นัสูืงสืำหรัับการัวิิจััยทางการั
จััดัการั	(Advance	Analysis	in	Management	Research)		ในัการัศึกษารัะดัับปรัิญญาเอก	สืาขั้าการัจััดัการั
คณะวิิทยาการัจััดัการั	มหาวิิทยาลัยสืงขั้ลานัครัินัทร์ั	โดัยยังคงแนัวิทางการัวิิเครัาะห์ดัั�งเดัิมและผสืมเทคนัิคใหม่ในั
บางเทคนิัค	โดัยมุ่งเน้ันัการัออกแบบ	การัปรัะมาณค่าและการัตีิควิาม	โดัยพยายามใช้้สัืญลักษณะทางสืถิิติิและ
คำศัพท์เฉพาะที�จัำเป็นั	และใช้้แนัวิคิดัพื�นัฐานัที�สื่งผลติ่อการัปรัะยุกต์ิใช้้เทคนัิคเหล่านัี�	ผู้เขั้ียนัไดั้ใช้้โปรัแกรัม	RStuio
มาใช้้ในัหนัังสืือนัี�ทั�งเล่มดั้วิยเหติุผลหลายปรัะการั	ไดั้แก่	เป็นัโอเพนัซึอรั์สืทำให้เป็นัโปรัแกรัมฟัรัี	มีแนัวิทางและ
ติัวิอย่างการัใช้้คำสืั�งที�หาไดั้ง่ายบนัอินัเทอรั์เนัติ	มีชุ้ดัโปรัแกรัม	(package)	จัำนัวินัมากและพัฒนัาอย่างติ่อเนัื�อง
และที�สืำคัญคือสืามารัถิสืรั้างขั้้อมูลภาพ	(data	vistualization)	ซึึ�งจัะช้่วิยให้นัักวิิจััยแปลควิามหมายทางสืถิิติิไดั้ดัีขั้ึ�นั
หนัังสืือเล่มนัี�พยายามเสืนัอในัแนัวิทางที�เรัียบง่าย	ทำให้มีควิามเหมาะสืมสืำหรัับการัวิิเครัาะห์พหุติัวิแปรัที�เนั้นัการั
ปรัะยุกต์ิใช้้สืำหรัับผู้ที�ไม่ใช่้นัักสืถิิติิได้ัเป็นัอย่างดีั	จัากปรัะสืบการัณ์ในัการัทดัลองการัใช้้หนัังสืือนัี�กับนัักศึกษา
ปรัิญญาเอกไม่นั้อยกวิ่าห้าปี	จัากนัักศึกษาที�ไม่พื�นัฐานัการัใช้้สืถิิติิขั้ั�นัสูืงและการัใช้้	R	หรัือ	RStuido	มาก่อนั	พบวิ่า
นัักศึกษาสืามารัถิเรัียนัรัู้โดัยใช้้เวิลาไม่นัานัภายใติ้คำแนัะนัำเพียงเล็กนั้อยเท่านัั�นั	นัอกจัากนัี�นัักวิิจััยสืามารัถิ
ดัาวินั์โหลดัคำสืั�งและขั้้อมูล	(chapter	resource)	สืำหรัับการัวิิเครัาะห์ในัแติ่ละบทไดั้จัาก	QR	code	ที�ผู้เขั้ียนัไดั้
เติรัียมไว้ิในัแติ่ละบท
	 ผู้เขั้ียนัมีควิามมุ่งมั�นัจัะสืร้ัางควิามเขั้้าใจัที�มั�นัคงเกี�ยวิกับหลักการัทางสืถิิติิและการัจััดัการัที�เป็นัพื�นัฐานัขั้อง
การัวิิเครัาะห์ขั้ั�นัสืูงพหุติัวิแปรัในัแบบที�ไม่สืรั้างควิามหนัักใจักับนัักวิิจััยมากเกินัไปและหวิังวิ่าหนัังสืือเล่มนัี�จัะเป็นั
ปรัะโยช้นั์สืำหรัับนัักวิิจััยในัทุกรัะดัับ

อิศรััฏฐ์		รัินัไธิสืง
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)01(ิยม
	 การัวิิจััยทางพฤติิกรัรัมศาสืติร์ัเป็นัศาสืติรั์เช้ิงบูรัณาการัที�ผสืมผสืานัองค์ควิามรัู้จัากหลายสืาขั้า	อาทิ	จิัติวิิทยา
สืังคมวิิทยา	การับริัหารั	และเศรัษฐศาสืติร์ั	เพื�ออธิิบายพฤติิกรัรัมขั้องมนุัษย์อย่างรัอบด้ัานัและลึกซึึ�ง	จัำเป็นัติ้อง
อาศัยเครัื�องมือทางสืถิิติิขั้ั�นัสืูงที�มีควิามแม่นัยำและยืดัหยุ่นัในัการัวิิเครัาะห์ขั้้อมูล	หนัังสืือเล่มนัี�จัึงมีบทบาทสืำคัญ
ในัการัเป็นัสืะพานัเช้ื�อมรัะหว่ิางแนัวิคิดัเช้ิงทฤษฎีิจัากหลากหลายศาสืติร์ักับการัปรัะยุกติ์ใช้้วิิธีิการัทางสืถิิติิอย่าง
เป็นัรัะบบ	ช้่วิยให้นัักวิิจััยสืามารัถิสืังเครัาะห์องค์ควิามรัู้และสืรั้างขั้้อค้นัพบใหม่ที�มีคุณค่าเช้ิงวิิช้าการัและเช้ิงปฏิบัติิ
ไดั้อย่างแท้จัรัิง
	 จัุดัเดั่นัขั้องหนัังสืือเล่มนัี�คือการัเช้ื�อมโยงรัะหวิ่าง	“ทฤษฎิี”	และ	“การัปรัะยุกติ์ใช้้จัรัิง”	ไดั้อย่างช้ัดัเจันั	ผู้อ่านั
จัะไม่เพียงเขั้้าใจัหลักการัทางสืถิิติิเท่านัั�นั	แติ่ยังสืามารัถินัำควิามรัู้นัี�ไปใช้้ในัการัวิิเครัาะห์ขั้้อมูลและติอบคำถิามวิิจััย
ไดั้อย่างถิูกติ้องและมีปรัะสืิทธิิภาพ	โดัยเฉพาะการันัำเสืนัอขั้ั�นัติอนัการัวิิเครัาะห์	การัติรัวิจัสือบสืมมติิฐานั	และการั
แปลผล	ซึึ�งเป็นัหัวิใจัสืำคัญขั้องงานัวิิจััยที�มีคุณภาพ	
	 นัอกจัากนัี�	การัเลือกใช้้โปรัแกรัม	R	เป็นัเครัื�องมือหลักในัการัวิิเครัาะห์ขั้้อมูลถืิอเป็นัอีกหนัึ�งจุัดัแขั้็งขั้อง
หนัังสืือเล่มนัี�	เนัื�องจัากเป็นัเครัื�องมือที�มีปรัะสิืทธิิภาพสืูงและเปิดัโอกาสืให้ผู้เรัียนัสืามารัถิเขั้้าถิึงไดั้โดัยไม่มีขั้้อจัำกัดั
ดั้านัลิขั้สืิทธิิ�	สื่งเสืรัิมให้เกิดัการัเรัียนัรัู้และพัฒนัาทักษะอย่างยั�งยืนั	ขั้้าพเจั้ามีควิามเช้ื�อมั�นัวิ่าหนัังสืือเล่มนัี�จัะเป็นั
แหล่งควิามรัู้ที�มีคุณค่าและเป็นัปรัะโยช้น์ัอย่างยิ�งต่ิอ	นัักวิิจััยทางพฤติิกรัรัมศาสืติร์ั	และผู้อ่านัทุกท่านั	ทั�งในัการั
เพิ�มควิามรัู้และทักษะทางสืถิิติ	ิและการันัำไปปรัะยุกต์ิใช้้ในังานัวิิจััยอย่างแท้จัริัง	

ศาสืติรัาจัารัย์	เกียรัติิคุณ	ดัรั.	ดุัษฎิี	อินัทรัปรัะเสืรัิฐ	
นัายกสืมาคมพฤติิกรัรัมศาสืติรั์
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1. )91ม(01
	 ในับทนัำนัี�ผู้เขั้ียนัมีวิัติถิุปรัะสืงค์หลักอยู่สืองปรัะการัด้ัวิยกันั	ปรัะการัแรัก	ดั้วิยหนัังสืือเล่มนัี�ปรัะมวิลผล
ดั้วิย	RStudio	ทั�งเล่ม	มีควิามจัำเป็นัยิ�งที�นัักวิิจััยต้ิองเขั้้าใจัพื�นัฐานัการัใช้้	RStudio	ที�เพียงพอต่ิอการัใช้้งานั	ผู้เขั้ียนั
จัึงเรัิ�มด้ัวิยทำไมจึังใช้้	RStudio	ติามด้ัวิยวิิธีิการัติิดัติั�ง	ส่ืวินัปรัะกอบ	การักำหนัดั	theme	เพื�ออาจัทำให้สืภาพแวิดัล้อม
การัทำงานัขั้อง	RStudio	น่ัาทำงานัมากขั้ึ�นั		สืิ�งสืำคัญที�นัักวิิจััยต้ิองควิรัทำเขั้้าใจัคือการัทำงานัขั้อง	RStudio	และ
ชุ้ดัโปรัแกรัม	(package)	ซึึ�งหนัังสืือให้ควิามเขั้้าใจัพื�นัฐานัเพียงพอติ่อการัใช้้งานั	โดัยไม่จัำเป็นัต้ิองรัู้การัเขั้ียนัโค้ดั
มาก่อนั	นัักวิิจััยเพียงทำติามที�หนัังสืือให้แนัวิทางไวิ้	การันัำโค้ดั	และชุ้ดัโปรัแกรัมที�ได้ัไวิ้ในัหนัังสืือจัะทำให้นัักวิิจััย
เข้ั้าใจัมากขั้ึ�นั	และเมื�อใช้้ไปสืักรัะยะ	ผู้เขั้ียนัมั�นัใจัวิ่านัักวิิจััยจัะช้ื�นัช้อบการัใช้	้RStudio	
	 ปรัะการัที�สือง	ดั้วิยเหตุิวิ่าการัทดัสือบทางสืถิิติิไม่อาจัหลีกเลี�ยงการัจััดัการัขั้้อมูล	การัเติรัียมขั้้อมูล	การัทดัสือบ
ขั้้อติกลงเบื�องติ้นั	การัติรัียมขั้้อมูลมีควิามจัำเป็นัอย่างยิ�งทั�งในัแง่ขั้องการัติรัวิจัสือบและการัช้ำรัะขั้้อมูล	(screening
and	cleaning)	โดัยเฉพาะการัจััดัการัค่าผิดัพลาดั	(missing	value)	ค่าสุืดัโติ่ง	(outlier)	เพื�อให้ได้ัขั้้อมูลที�ดัีก่อนั
เขั้้าการัวิิเครัาะห์ใดั	ๆ	ขั้ณะเดีัยวิกันัในัการัติรัวิจัสือบข้ั้อติกลงเบื�องต้ินั	มักจัะมีขั้้อติกลงเบื�องต้ินัร่ัวิมกันัหลายปรัะการั
เช่้นั	การัแจักแจังปกติิ	(normality)	ควิามเป็นัเอกพันัธิ์ขั้องเมทรัิกซึ์ควิามแปรัปรัวินั	-	ควิามแปรัปรัวินัรั่วิม
(homogeneity	of	variance)	ควิามคงที�ขั้องควิามแปรัปรัวินัขั้องควิามคลาดัเคลื�อนั	(homosedasiticity)
เป็นัติ้นั	โดัยในับทนัี�ทำการัทดัสือบ	การัแปรัควิามหมาย	และแนัวิทางจััดัการัไวิ้เพื�อเป็นัแนัวิทางสืำหรัับนัักวิิจััย
ส่ืวินัขั้้อติกลงบางปรัะการั	เช้่นั	Sphericity	ซึึ�งการัติรัวิจัสือบเมทรัิกซ์ึสืหสืัมพันัธ์ิขั้องปรัะช้ากรัว่ิาเป็นัเมทรัิกซึ์
เอกลักษณ์หรืัอไม่ในัการัวิิเครัาะห์องค์ปรัะกอบเชิ้งสืำรัวิจั	ควิามสืัมพันัธ์ิเชิ้งเสื้นัติรัง		(linearity)	การัรั่วิมกันัเชิ้งเสื้นัพหุ
(collinerity)	ซึึ�งเป็นัเงื�อนัไขั้การัวิิเครัาะห์การัถิดัถิอยพหุคูณ	ผู้เขั้ียนัจัะให้แนัวิคิดั	(concept)	ไวิ้แต่ิการัทดัสือบจัะ
นัำเสืนัอในัแติ่ละบทที�เกี�ยวิข้ั้องเป็นัการัเฉพาะ
	 ผู้เขั้ียนัเห็นัวิ่านัักวิิจััยสืามารัถิเลือกอ่านัในับทที�ตินัเองสืนัใจัได้ั	เนัื�องจัากการัอธิิบายมีควิามเป็นัอิสืรัะขั้อง
แติ่ละบท	อาจัมีควิามเกี�ยวิข้ั้องกันับ้าง	เช้่นั	การัวิิเครัาะห์ฟัังก์ชั้นัการัจัำแนัก	(discriminnat	function	analysis)
กับการัวิิเครัาะห์ควิามแปรัปรัวินัพหุติัวิแปรั	(MANOVA)	แต่ิโดัยรัวิมแล้วิยังสืามารัถิเลือกก่อนัได้ัติามควิามสืนัใจั
ยกเวิ้นันัักวิิจััยที�ไม่มีพื�นัฐานั	R	หรัือ		RStudio	มาก่อนั	แนัะนัำวิ่ามีควิามจัำเป็นัติ้องอ่านับทที�	1	นัี�	และหากให้เกิดั
ควิามเช้ี�ยวิช้าญควิรัศึกษาจัากแหล่งอื�นัเพิ�มเติิมที�สืามารัถิสืืบค้นัโดัยง่ายในัออนัไลน์ั
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2. แ(C(01 R แลC RStudio
	 2.1	 ทำไมต้องต้อง	R	และ	RStudio
		 R	เป็นัภาษาโปรัแกรัมโอเพนัซึอรั์สืที�ไดั้รัับควิามนัิยมภาษาหนัึ�ง	หากนัักวิิจััยเคยมีควิามรัู้พื�นัฐานัดั้านัการั
เขั้ียนัโปรัแกรัมในั	Python,	Swift	หรัือ	C	มาก่อนัแล้วิ	นัักวิิจััยสืามารัถิเรัียนัรัู้ไวิยากรัณ์ขั้อง	R	ไดั้อย่างรัวิดัเรั็วิหาก
นัักวิิจััยเพิ�งเรัิ�มใช้้	R	ก็มีแหล่งขั้้อมูลออนัไลนั์มากมายที�นั่าสืนัใจัและฟัรัีให้นัักวิิจััยเรัียนัรัู้	อันัที�จัรัิงแล้วิ	R	ไม่เพียงแติ่
มีช้ื�อเสืียงวิ่าเป็นัภาษาโปรัแกรัมที�เรัียนัรัู้ไดั้ง่ายกวิ่า	Python	เท่านัั�นั	นัักพัฒนัา	R	มีช้่อง	YouTube	ยอดันิัยมที�ให้
คำแนัะนัำการัเขั้ียนัโค้ดัแบบสืดัโดัยใช้้	R	และ	RStudio	ขั้ณะเดัียวิกันัมีหนัังสืือโอเพนัซึอรั์สื	R	แล	RStudio
จัำนัวินัมาก	นัอกจัากนัี�ยังมีแหล่งขั้้อมูลนัคุณวิิจััยภาพสูืง	และฟัรัีอีกมากมายเกี�ยวิกับการัสืรั้างกรัาฟิักที�สืวิยงาม	
	 RStudio	เป็นัแอปพลิเคชั้นัที�เขั้ียนัด้ัวิยคำสืั�งแบบ	R	ผู้เขั้ียนัใช้้	RStudio	ติลอดัทั�งเล่มเพรัาะทำให้การัใช้้	R
ง่ายขั้ึ�นัมาก	นัอกจัากนัี�	อินัเทอรั์เฟัซึ	RStudio	ก็มีลักษณะเหมือนักันัสืำหรัับ	Windows,	Mac	OS	และ	Linux
เมื�อติิดัติั�ง	RStudio	หรืัอแม้แต่ิ	RStudio	online	นัักวิิจััยสืามารัถิเปิดัได้ัเช้่นัเดีัยวิกับโปรัแกรัมอื�นั	ๆ	บนัคอมพิวิเติอร์ั
โดัยปกติิแล้วิจัะเปิดัโดัยคลิกไอคอนับนัเดัสืก์ท็อป	RStudio	ได้ักลายเป็นัสืภาพแวิดัล้อมการัพัฒนัาแบบบูรัณาการั
(integrated	development	environment	[IDE])	ที�ไดั้รัับควิามนัิยมสืูงสุืดัสืำหรัับผู้ใช้้	R	นัับติั�งแติ่เปิดัติัวิในัปี
2011	โดัย	Posit	ซึึ�งเป็นับรัิษัทวิิทยาศาสืติรั์ข้ั้อมูลโอเพนัซึอร์ัสื
	 การัที�	RStudio	ไดั้รัับการันัำมาใช้้ในัวิงกวิ้างโดัยชุ้มช้นัการัวิิเครัาะห์ข้ั้อมูลนัั�นัเกิดัจัากการัที�	RStudio	นัำเสืนัอ
แนัวิทางแบบบูรัณาการั	และเรัียบง่ายแก่ผู้ใช้้ในัการัดัำเนิันัการัวิิเครัาะห์ขั้้อมูลการัแสืดังภาพ	และการัสืร้ัางโมเดัล
ทางสืถิิติิ	ไม่วิ่าจัะเป็นันัักวิิจััย	นัักวิิเครัาะห์ขั้้อมูล	หรืัอสืถิิติิศาสืติร์ั	อินัเทอร์ัเฟัซึที�เป็นัมิติรักับผู้ใช้้ในัการัเรัียนัรัู้และ
ใช้้งานัไดั้ง่าย	แม้ว่ิา	RStudio	จัะหมายถิึง	IDE	ที�ใช้้เมื�อเขั้ียนัโค้ดัในั	R	แติ่จัะเขั้้าใจัไดั้ดีักวิ่าวิ่าเป็นัชุ้ดัเครัื�องมือที�ช้่วิย
ให้นัักวิิเครัาะห์จััดัการัแสืดังภาพสืร้ัางแบบจัำลองข้ั้อมูล	และปรัับใช้้แบบจัำลองการัเรัียนัรัู้ขั้องเครัื�องจัักรั	(machine
learning)	RStudio	คือโปรัแกรัมแก้ไขั้โค้ดัที�มาพรั้อมกับเครัื�องมือเน้ันัไวิยากรัณ์	เติิมโค้ดั	และดัีบัก	(debug)
จัึงเป็นัเครัื�องมือที�นัักวิิจััยสืามารัถิเขั้ียนัโค้ดั	R	ได้ัโดัยติรัง	ด้ัวิยคุณสืมบัติิเหล่านัี�จัะทำให้กรัะบวินัการัเขั้ียนัโค้ดัรัาบรัื�นั
และมีปรัะสืิทธิิภาพมากขั้ึ�นั	ซึึ�งจัะกลายเป็นัสืิ�งสืำคัญมากขั้ึ�นัเมื�อฐานัขั้องโค้ดัมีควิามซึับซึ้อนัมากขั้ึ�นั	นัอกจัากนัี�ยังมา
พรั้อมกับคอนัโซึล	(console)	แบบโติ้ติอบที�ให้นัักวิิจััยเรีัยกใช้้สืครัิปติ์	(script)	ทั�งหมดัขั้องโค้ดั	R	เพื�อดัูผลลัพธิ์
แบบเรัียลไทม์
	 RStudio	มีเบรัาวิ์เซึอรั์พื�นัที�ทำงานัที�ติิดัติามติัวิแปรั	ฟัังก์ช้ันั	รัายการั	และเฟัรัมขั้้อมูลที�ใช้้ในัสืภาพแวิดัล้อม
ปัจัจัุบันัขั้องนัักวิิจััย	RStudio	มีหนั้าติ่างการัพล็อติ	(plot)	ในัติัวิที�แสืดังพล็อติใดั	ๆ	ที�นัักวิิจััยสืรั้างขั้ึ�นัขั้ณะทำการั
วิิเครัาะห์ขั้้อมูลเช้ิงสืำรัวิจั	นัักวิิจััยสืามารัถิแก้ไขั้และบันัทึกพล็อติเหล่านัี�ไดั้โดัยติรัง	นัอกจัากนัี�	RStudio	สืามารัถิ
บูรัณาการักับเครัื�องมืออื�นั	ๆ	ได้ัดัีติัวิอย่างเช้่นั	นัักวิิจััยสืามารัถินัำการัควิบคุมเวิอร์ัช้ันัมาใช้้กับ	Git	ซึึ�งช่้วิยให้นัักวิิจััย
ติิดัติามและจััดัการัการัเปลี�ยนัแปลงขั้องโค้ดัในัช้่วิงเวิลาหนัึ�ง	และกับคนัเขั้ียนัโค้ดั	R	หลายคนัที�ทำงานัในัโปรัเจั็กติ์
เดัียวิกันัไดั้	นัอกจัากนัี�ยังรัองรัับ	Shiny	อีกด้ัวิย	ดัังนัั�นันัักวิิจััยจึังสืรั้างแอปพลิเคช้ันัเวิ็บ	หรัือแดัช้บอร์ัดัแบบโต้ิติอบ
ในั	R	ได้ัโดัยไม่ติ้องรัู้เรัื�องการัพัฒนัาหรืัอการัปรัับใช้้เวิ็บใดั	ๆ	ทั�งสืิ�นั	RStudio	นัอกจัากทำงานับนัเดัสืก์ท็อปแล้วิยัง
สืามารัถิทำงานับนัแพลติฟัอรั์มออนัไลนั์ไดั้
	 ที�กล่าวิมาเป็นัควิามสืามารัถิขั้อง	RStudio	แติ่สืำหรัับหนัังสืือเล่มนัี�นัักวิิจััยไม่จัำเป็นัติ้องมีทักษะขั้ั�นัสืูงใดั	ๆ
เพียงแต่ิเขั้้าใจัการัใช้้พื�นัฐานั	ส่ืวินัการัเขั้ียนัคำสืั�ง	ฟัังก์ช้ันัต่ิาง	ๆ	นัักวิิจััยสืามารัถิใช้้ติามหนัังสืือนัี�	ได้ัเลย	และยังสืามารัถิ
มีทางเลือกอื�นั	ๆ	สืำหรัับการัวิิเครัาะห์สืถิิติิเดีัยวิกันัและด้ัวิยฟัังก์ช้ันัจัาก	package	ที�ติ่างกันัดั้วิยการัเรัียนัรู้ัจัาก
เวิ็บไซึติ์ติ่าง	ๆ	จัำนัวินัมาก	ในัหนัังสืือนัี�จัะใช้้	RStudio	สืำหรัับการัวิิเครัาะห์ขั้้อมูล	การัสืรั้างขั้้อมูลภาพ	และการั
แปลควิามหมายทางสืถิิติิเป็นัหลัก
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	 2.2	 กิารติดตั�ง	R	และ	RStudio
		 RStudio	IDE	คือ	Integrated	Development	Environment	โปรัแกรัมที�ทำงานัร่ัวิมกับโปรัแกรัม	R	ซึึ�ง
เอื�อ	ให้เหมาะสืมกับการัใช้้งานัและการัพัฒนัาโปรัแกรัมให้สืะดัวิกมากขั้ึ�นั	เช้่นั	การัทำงานัรั่วิมกับ	Markdown,
Latex	เป็นัติ้นั	ขั้้อดัีขั้อง	RStudio	ยังสืามารัถิทำงานัรั่วิมกับ	Version	Control	เช้่นั	Git	และ	Github	อีกดั้วิย	ซึึ�ง
เหมาะกับงานัทางด้ัานั	Data	Scientists	อย่างยิ�ง	โดัยการัใช้้งานัโปรัแกรัม	RStudio	นัั�นั	ผู้ใช้้จัะต้ิองทำการัติิดัติั�ง
อยู่สืองขั้ั�นัติอนัดั้วิยกันั	คือ	การัติิดัติั�งโปรัแกรัม	R	และการัติิดัติั�งโปรัแกรัม	RStudio
	 	 2.2.1	 	ติิดัติั�ง		R	ไปที�	http://www.r-project.org
	 	 2.2.2	 	คลิก	ที�	CRAN		หัวิข้ั้อ	Download	หรัือ	คลิกที�			Download	R	หรัือ	CRAN	Mirror
	 	 	 	 	 ในัขั้้อควิาม	Getting	Started

 

	 	 2.2.3	 	คลิก	Link	ใติ้ขั้้อควิาม	Thailand

	 กรัณีไม่สืามารัถิติิดัติั�งผ่านัปรัะเทศไทยได้ั	ให้ไปที�ดั้านับนัจัะพบข้ั้อควิามดัังขั้้างล่าง	ให้คลิกที�	CRAN	Mirror	
HowTo	
 

จัะไปที�เพจั	คลิกที�	https://cran.r-project.org
	 	 2.2.4	 	 เลือก	version	และ	OS	ที�เหมาะกับเครัื�อง	หลังจัากนัั�นัเขั้้าสืูก่รัะบวินัการัติิดัติั�งปกติิ
 

	 	 โปรัแกรัม	R	ที�พรั้อมใช้้งานั
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	 	 2.2.5	 	การัติิดัติั�ง	Rstudio
		 	 RStudio	เป็นัแอปพลิเคชั้นัเช่้นัเดัียวิกับโปรัแกรัมทั�วิไปบนัคอมพิวิเติอรั์	แติ่	RStudio	จัะช้่วิยนัักวิิจััย
เขั้ียนัคำสืั�งดั้วิย	R	ผู้เขั้ียนัใช้้	RStudio	ติลอดัทั�งเล่มเพรัาะทำให้การัใช้้	R	ง่ายขั้ึ�นัมาก	นัอกจัากนัี�	อินัเทอรั์เฟัซึ
RStudio	ก็มีลักษณะเหมือนักันัสืำหรัับ	Windows,	Mac	OS	และ	Linux	ซึึ�งจัะช่้วิยให้ฉันัจัับคู่หนัังสืือกับปรัะสืบการัณ์
สื่วินัตัิวิขั้องนัักวิิจััยได้ัดัาวิน์ัโหลดั		RStudio	ได้ัฟัรีัที�เวิ็บไซึติ์	http://www.rstudio.com/ide/download/	หรืัอ
https://posit.co/downloads/	แล้วิคลิกที�ปุ�ม	DOWNLOAD	RSTUDIO	แล้วิทำติามคำแนัะนัำ	เมื�อนัักวิิจััยติิดัติั�ง
RStudio	แล้วิ	เรัาสืามารัถิเปิดัใช้้งานัได้ัเช้่นัเดีัยวิกับโปรัแกรัมอื�นั	ๆ	โดัยปกติิแล้วิจัะเปิดัโดัยคลิกไอคอนับนัเดัสืก์ท็อป

ภาพ	1-1		หนั้าติ่างแสืดังการัติิดัติิดัติั�ง	R	สืำเรั็จัและพรั้อมใช้้งานั

ภาพ	1-2	การัดัาวินั์โหลดั	RStudio	และ	icons	ขั้อง	R	และ	RStudio	ที�พรั้อมใช้้งานั
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 2.3	User	interface	ข้อง	RStuido

	 User	interface	ขั้อง	RStudio	มีแผงหลัก	4	แผง	(pane)	ได้ัแก่
 	 2.3.1		Source	pane
		 	 Source	pane	เป็นัพื�นัที�สืำหรัับเขั้ียนัคำสืั�ง	หรัือแหล่งที�มาขั้้อมูลและคำสืั�ง	(script)	แผงซึอรั์สื	ช่้วิยให้
ผู้ใช้้สืามารัถิดัูและแก้ไขั้ไฟัล์ที�เกี�ยวิขั้้องกับโค้ดัติ่าง	ๆ	เช้่นั	.R,	.rmd,	.qmd,	.py,	.css	หรัือไฟัล์ขั้้อควิามทั�วิไป	เช้่นั
.txt	หรัือ	.md	โดัยค่าเรัิ�มต้ินั	แผงซึอรั์สืจัะอยู่ด้ัานับนัซึ้าย	และสืามารัถิเปิดัใช้้งานัไดั้โดัยการัเปิดัไฟัล์ที�แก้ไขั้ไดั้ในั
RStudio	ไฟัล์เพิ�มเติิมที�เปิดัขั้ึ�นัแติ่ละไฟัล์จัะถิูกเพิ�มเป็นัแท็ปใหม่ภายในัแผงซึอรั์สื	สืามารัถิเพิ�ม	“คอลัมนั์”	ซึอรั์สื
เพิ�มเติิมทางด้ัานัซ้ึายขั้องแผงหลักทั�งสืี�แผงได้ัหากต้ิองการัเพิ�มคอลัมน์ัซึอร์ัสืเพิ�มเติิม	ให้ไปที�เมนูั	Tools->Global
Options	->	Pane	Layout	->	Add	Source	Column	ซึึ�งให้ควิามสืามารัถิในัการัทำงานักับไฟัล์ซึอร์ัสืสืองไฟัล์
(หรัือมากกว่ิา)	พรั้อมกันัภายในัแผงซึอรั์สื
	 	 ไฟัล์ซึอรั์สืแติ่ละไฟัล์สืามารัถิเปิดัในัหนั้าติ่างขั้องติัวิเองไดั้	แทนัที�จัะเปิดัเฉพาะในัแผงซึอรั์สืเท่านัั�นั
หนั้าติ่างซึอรั์สืช้่วิยให้นัักวิิจััยแก้ไขั้ไฟัล์นัอกหนั้าติ่างหลักขั้อง	RStudio	ไดั้	ซึึ�งมีปรัะโยช้นั์ในัการัแบ่งงานัขั้องนัักวิิจััย
รัะหวิ่างมอนัิเติอรั์หลายติัวิ	หรัือเพิ�มพื�นัที�ให้กับโปรัแกรัมแก้ไขั้	ในัหนัังสืือนัี�จัะเขั้ียนัคำสืั�งจัากแผงซึอรั์สืทั�งหมดั
		 	 จัากภาพ	1-3	Source	pane	แสืดังติัวิอย่างการัเรีัยกใช้้	semTool	package	และ	semPlot	package
จัากคำสืั�ง	library	และใช้้ฟัังก์ชั้นั	reliability	จัะแสืดังผลในั	Console	pane	สืร้ัางแผนัภาพจัากฟัังก์ช้ันั	semPaths
แสืดังผลในั	Output	pane	โดัยสืั�ง	run	คำสืั�งจัากปุ�ม	run	จัากเมนัูบาร์ัดั้านับนั

ภาพ	1-3	สื่วินัปรัะกอบขั้อง	User	interface	ขั้อง	RStudio
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	 	 2.3.2		Console	pane
		 	 Console	pane	ทำหนั้าที�เช้่นัเดัียวิกับ	console	ในั	R	ซึึ�งสืามารัถิเขั้ียนัคำสืั�ง	และสืั�ง	run	ไดั้	โดัยค่า
เรัิ�มติ้นัแล้วิ	แผงคอนัโซึลจัะเป็นัแผงดั้านัล่างซึ้าย	แผงคอนัโซึลจัะให้พื�นัที�สืำหรัับเรัียกใช้้โค้ดัแบบโติ้ติอบผลจัากการั
run	คำสืั�งจัาก	Sources	pane	โดัยปกติิแล้วิแผงคอนัโซึลจัะเช้ื�อมโยงกับ	R	ดั้วิยการัใช้้แพ็คเกจั	reticulate	package
แผงคอนัโซึลยังสืามารัถิจััดัเติรัียมคอนัโซึล	Python	ไดั้ดั้วิย	นัอกจัากนัี�	แผงคอนัโซึลยังรัวิมถิึงแท็บเทอรั์มินััลในัติัวิ
สืำหรัับเรัียกใช้้คำสืั�งรัะบบเพิ�มหรัือลบเทอรั์มินััลในัตัิวิเพิ�มเติิม	รัวิมถิึงการัควิบคุมทั�วิไปขั้องเทอร์ัมินััลที�เลือกในั
ปัจัจัุบันั	แท็บงานัพื�นัหลังให้ควิามสืามารัถิในัการัสื่งสืครัิปติ์	R	ที�รัันัยาวินัานัไปยังงานัเบื�องหลังในัพื�นัที�และรัะยะไกล
ฟัังก์ช้ันันัี�จัะช่้วิยปรัับปรัุงปรัะสืิทธิิภาพขั้องนัักวิิทยาศาสืติรั์ขั้้อมูล	และนัักวิิเครัาะห์ที�ใช้้	R	ไดั้อย่างมาก	เนัื�องจัาก
พวิกเขั้าสืามารัถิทำงานัในั	RStudio	ติ่อไปไดั้ในัขั้ณะที�งานักำลังทำงานัอยู่เบื�องหลัง
	 	 2.3.3	Environtments	pane
	 	 Environtments	pane	โดัยค่าเรัิ�มติ้นั	แผงสืภาพแวิดัล้อมจัะอยู่ที�ดั้านับนัขั้วิา	และปรัะกอบดั้วิยแท็บ
สืภาพแวิดัล้อม	ปรัะวิัติิ	การัเช้ื�อมติ่อ	การัสืรั้าง	และรัะบบควิบคุมเวิอร์ัช้ันั	(VCS)
	 	 Environtments	tap
		 	 แท็บสืภาพแวิดัล้อมจัะแสืดังวิัติถิุ	R	ที�บันัทึกไวิ้ในัปัจัจัุบันั	กล่าวิคือเมื�อเรัาเขั้ียนัโค้ดัในัแผงซึอรั์สื	และ
สืั�ง	run	โค้ดัจัะถิึง	เขั้ียนัลงในัแผงสืภาพแวิดัล้อมติลอดัรัะยะเวิลาขั้องเซึสืช้ันั	(session)	ปัจัจัุบันั	แถิบเมนัูสืภาพ
แวิดัล้อมช่้วิยให้โหลดัหรืัอบันัทึกเวิิร์ักสืเปซึ	R	(workspace)	นัำเขั้้าชุ้ดัขั้้อมูลแบบโต้ิติอบจัากไฟัล์ขั้้อควิาม	Excel/
SPSS/SAS/Stata	หรืัออื�นั	นัอกจัากนัี�ยังแสืดังหน่ัวิยควิามจัำที�ใช้้โดัยเซึสืชั้นั	R	ที�ใช้้งานัอยู่	และไอคอนัไม้กวิาดัเพื�อ
ลบวิัติถิุสืภาพแวิดัล้อมปัจัจัุบันัทั�งหมดั
	 	 History	tap
	 	 แท็บปรัะวัิติิจัะแสืดังคำสืั�งที�ดัำเนิันัการัในัเซึสืชั้นัปัจัจุับันัพร้ัอมกับการัค้นัหา	มีปุ�มสืำหรัับโหลดั/บันัทึก
ปรัะวิัติิคำสืั�งไปยังไฟัล์	รัวิมถิึงการัสื่งคำสัื�งที�เลือกไปยังคอนัโซึล	หรัือแทรักคำสืั�งนัั�นัลงในัเอกสืารัการัทำงานัปัจัจัุบันั
มีปุ�มลบสืำหรัับลบปรัะวิัติิที�เลือกหรัือปุ�มไม้กวิาดัสืำหรัับลบปรัะวิัติทิั�งหมดัขั้องเซึสืชั้นัปัจัจัุบันั
	 	 Connection	tap
	 	 แท็บการัเช้ื�อมติ่อจัะแสืดังการัเช้ื�อมติ่อกับฐานัขั้้อมูลในัพื�นัที�หรัือรัะยะไกล	สืามารัถิเพิ�มการัเช้ื�อมติ่อ
ที�เป็นัไปได้ัเพิ�มเติิมได้ัโดัยการัติิดัติั�งไดัรัเวิอรั์ฐานัข้ั้อมูลหรืัอแพ็กเกจั	R	เฉพาะ	นัักวิิจััยสืามารัถิคลิกการัเช้ื�อมต่ิอที�
พรั้อมใช้้งานัแบบโติ้ติอบไดั้	และจัะมีโค้ดั	R	ทั�วิไปให้เพื�อลงทะเบียนัการัเช้ื�อมติ่อที�ใช้้งานัอยู่กับแหล่งขั้้อมูลนัั�นั	เมื�อ
สืร้ัางการัเช้ื�อมติ่อแล้วิ	นัักวิิจััยสืามารัถิสืำรัวิจัติารัางที�พร้ัอมใช้้งานัในัการัเช้ื�อมติ่อนัั�นัได้ั	นัอกจัากนัี�ยังมีปุ�มเช้ื�อมติ่อ
สืำหรัับสืร้ัางการัเช้ื�อมต่ิอในัคอนัโซึล	R	สืคริัปต์ิ	หรืัอสืมุดับันัทึก	รัวิมถึิงการัคัดัลอกโค้ดัที�เกี�ยวิข้ั้องไปยังคลิปบอร์ัดั
ไดั้หากมี
	 	 2.3.4	Output	pane
		 	 Output	pane	โดัยค่าเรัิ�มต้ินั	แผงผลลัพธ์ิจัะเป็นัแผงด้ัานัล่างขั้วิา	และจัะแสืดังผลลัพธ์ิติ่าง	ๆ	เช้่นั
พล็อติ	เนัื�อหา	HTML	หรัือไฟัล์บนัดัิสืก์	แผงนัี�ปรัะกอบดั้วิยแท็บ	ไฟัล์	พล็อติ	แพ็กเกจั	R	วิิธิีใช้้	บทช้่วิยสือนั	โปรัแกรัมดัู
และการันัำเสืนัอ	
	 	 Files	tap
			 	 แท็บนัี�ให้การัสืำรัวิจัแบบโต้ิติอบขั้องโปรัเจั็กติ์	R	ปัจัจัุบันัพรั้อมกับไดัเรั็กทอรีัทั�งหมดั	มีติัวิเลือกแถิบ
เมนัูสืำหรัับการัเพิ�มโฟัลเดัอร์ัใหม่	ไฟัล์วิ่างใหม่	การัลบ/เปลี�ยนัช้ื�อไฟัล์	ติลอดัจันัแผงรูัปเฟืัองสืำหรัับฟัังก์ช้ันัเพิ�มเติิม
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	 	 Plots	tap
		 	 แท็บนัี�จัะแสืดังรูัปภาพคงที�ที�สืรั้างโดัยโค้ดัจันักว่ิาจัะเรัิ�มเซึสืชั้นัใหม่	มีลูกศรัย้อนักลับและไปขั้้างหนั้า
สืำหรัับการันัำทางรัะหว่ิางพล็อติเก่าและใหม่กว่ิา		คุณลักษณะซึูม	ปุ�มส่ืงออกสืำหรัับบันัทึกผลลัพธ์ิที�แสืดัง	ปุ�มลบ
สืำหรัับลบภาพที�แสืดังอยู่ในัปัจัจัุบันั	และไอคอนัไม้กวิาดัที�จัะล้างพล็อติช้ั�วิครัาวิทั�งหมดัจัากแท็บนัี�	ซึึ�งจัากภาพจัะ
เป็นัการัแสืดังแผนัภาพเมทรัิกซึ์สืหสืัมพันัธิ์จัากคำสืั�งในัแผงซึอร์ัสื
	 	 Packages	tap
		 	 แท็บแพ็คเกจัช่้วิยให้ดัูแพ็คเกจั	R	ที�ติิดัติั�งอยู่ในัปัจัจุับันัไดั้	และมีแถิบค้นัหาสืำหรัับค้นัหาไลบรัารีั
แพ็คเกจัปัจัจัุบันั	มีปุ�มติดิัติั�งและอัปเดัติสืำหรัับการัติิดัติั�งแพ็คเกจัใหม่หรืัออัปเดัติแพ็คเกจัที�เลือกไวิ้แล้วิ
	 	 Help	tap
		 	 แท็บควิามช้่วิยเหลือใช้้เพื�อแสืดังเอกสืารัแพ็คเกจัและคำอธิิบายสืั�นั	ๆ	มีลูกศรัสืำหรัับนัำทางไปขั้้างหนั้า
และขั้้างหลังเมื�อดัูหนั้าควิามช้่วิยเหลือเพิ�มเติิม	ไอคอนัหนั้าแรักจัะกลับไปที�หนั้าควิามช้่วิยเหลือทั�วิไปพรั้อมลิงก์ไป
ยังทรััพยากรั	คู่มือ	การัอ้างอิง	และการัสืนัับสืนัุนั	Posit	ในัการัรัับควิามช้่วิยเหลือเกี�ยวิกับฟัังก์ชั้นั	R	เฉพาะ	ให้ใช้้
รัูปแบบ	?functionName	หรัือ	help(functionName)	ติัวิอย่างเช้่นั	?	paste	เมื�อสัื�ง	run	จัะเปิดัหนั้าควิามช้่วิยเหลือ
สืำหรัับฟัังก์ช้ันั	paste()
	 	 Tutorial	tap
		 	 แท็บบทช่้วิยสือนัใช้้สืำหรัับโหลดับทช่้วิยสือนัการัเรัียนัรัู้แบบโต้ิติอบ	บทช่้วิยสือนัเหล่านัี�มอบสืภาพแวิดัล้อม
แบบโติ้ติอบเพื�อก้าวิผ่านับทเรัียนัที�ผู้เขีั้ยนัแพ็คเกจัหรัือผู้สือนัเขั้ียนัขั้ึ�นั
	 	 Viewer	tap
	 	 แท็บตัิวิแสืดังใช้้เพื�อแสืดังเนัื�อหาเวิ็บ	เช้่นั	แอป	Shiny	หน้ัาเวิ็บที�สืร้ัางโดัย	Quarto	หรัือ	วิิดัเจ็ัติ
HTML	แบบโติ้ติอบ	เช่้นั	กรัาฟัแบบ	Plotly
	 	 Presentation	tap
	 	 แท็บการันัำเสืนัอใช้้เพื�อแสืดังสืไลด์ั	HTML	ที�สืรั้างโดัยใช้้รัูปแบบ	revealjs	ขั้อง	Quarto

 2.4	กิารกิำหนื้ด	theme
		 ในัส่ืวินั	Windows	ขั้อง	RStudio	เรัาสืามารัถิกำหนัดั	themes	ไดั้โดัยไปที�	Tools	>	Global	Options…
เลือก	Appearance	แล้วิกำหนัดัลักษณะติ่าง	ๆ	ติามที�ต้ิองการั	ในัสื่วินั	Editor	theme	จัะเกี�ยวิขั้้องกับสืีพื�นั	ตัิวิหนัังสืือ
ที�ถิูกออกแบบไวิ้แล้วิ	ในัตัิวิอย่างผู้เขั้ียนัเลือก	Monokai_Idsaratt2	ซึึ�งเป็นั	theme	ผู้เขั้ียนักำหนัดัขั้ึ�นัเอง	นัอกเหนืัอ
ไปจัาก	theme	มาติรัฐานัที�มีอยู่

	 2.5	กิารทำงานื้ข้อง	RStudio
	 โปรัแกรัม	RStudio		จัะทำงานัก็ติ่อเมื�อเรัา	ป้อนัคำสืั�งเขั้้าไป	และคำสืั�งที�ป้อนัเขั้้าไป	โดัยโปรัแกรัมจัะมีควิาม
ไวิติ่อคำสืั�งค่อนัข้ั้างมาก	กล่าวิคือ	การัเขั้ียนัคำสืั�งจัะต้ิองอยู่ในัรูัปขั้องภาษาที�กำหนัดัขั้ึ�นัมาเฉพาะ	R	นัักวิิจััยสืามารัถิ
ป้อนัคำสืั�งในัสื่วินั	Source	pane	หรัือเป็นัชุ้ดัคำสืั�งจัากแฟั้มที�เติรัียมไว้ิ	(script.R)	สื่วินัขั้้อมูลสืำหรัับใช้้กับโปรัแกรัม
RStudio	มีหลากหลายรัูปแบบ	เช้่นั	ในัรัูปขั้องเวิคเติอร์ั	(Vector)	เมทรัิกซึ์	(metrics)	ดัาติ้าเฟัรัม	(data	frames)
ซึึ�งเป็นัชุ้ดัขั้้อมูล	เป็นัติ้นั
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ภาพ	1-4	การัปรัับ	theme

	 การัทำงานัขั้องโปรัแกรัม	RStudio	จัะมีการักำหนัดัให้สืิ�งที�เรัาติ้องการัคำนัวิณหรืัอปรัะมวิลผลอยู่ในัรูัป
ขั้องวัิติถุิ	(objects)	โดัยเรัาสืามารัถิกำหนัดัค่าต่ิาง	ๆ	ให้กับวัิติถุินัี�ได้ั	เช้่นั	ข้ั้อมูล	ฟัังก์ช้ันั	กรัาฟั	ผลการัวิิเครัาะห์
และอื�นั	ๆ	ทุก	ๆ	วิัติถิุจัะติ้องบอกวิ่าเรัาจัะทำอะไรักับมันั	ทุกวัิติถิุจัะถิูกบันัทึกไวิ้ในัหนั่วิยควิามจัำ	ติลอดัช้่วิงการั
วิิเครัาะห์ขั้้อมูลขั้องเรัา	เรัาสืามารัถิเรัียกฟัังก์ช้ันัพื�นัฐานัขั้ึ�นัมาใช้้ไดั้โดัยปกติิ	แติ่ถิ้าฟัังก์ช้ันัที�เป็นัการัเฉพาะ	เช้่นั
การัวิิเครัาะห์สืถิิติิขั้ั�นัสืูง	หรัือการัสืรั้างภาพจัากโมเดัลจัำเป็นัติ้องใช้้ชุ้ดัโปรัแกรัมโดัยเฉพาะที�เรัียกวิ่า	packages
ซึึ�งเรัาจัะติ้องเรัียก	packages	นัั�นัมาใช้้ก่อนัทำการัวิิเครัาะห์ขั้้อมูล	แติ่ถิ้าในัโปรัแกรัมไม่มี	packages	นัั�นั	นัักวิิจััย
ติ้องติิดัติั�ง	(install)	เสืียก่อนัซึึ�งทำไดั้ง่าย	เพียงใช้้คำสืั�ง	install.packages	()		ใสื่ช้ื�อ	packages	ที�ติ้องการัติิดัติั�งในั
()	โปรัแกรัมก็จัะติิดัติั�งให้อัติโนัมัติิ	แติ่เครัื�องคอมพิวิเติอรั์ขั้องเรัาติ้องเช้ื�อมติ่อกับอินัเทอร์ัเนั็ติ
	 ในัการักำหนัดัฟัังก์ช้ันัต่ิาง	ๆ	นัั�นั	ในัโปรัแกรัม	R	มักนิัยมใช้้สืัญลักษณ์	<-	แทนัการัใช้้เครัื�องหมาย	=	ตัิวิอย่าง
คำสืั�ง	X	<-	rnom(10)
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	 จัากคำสืั�ง	หมายควิามวิ่าเรัาสืร้ัางเวิกเติอร์ัขั้้อมูลให้กับวิัติถุิ	ช้ื�อ	X	โดัยมีเลขั้อย่างสืุ่ม	(random)	จัำนัวินั	10	ค่า
ที�มีการักรัะจัายแบบแจักแจังปกติิ	(normal	distribution)	เรัาอาจัใช้้เครัื�องหมาย	=	แทนัไดั้บางกรัณี	แติ่อาจัไม่
สืามารัถิใช้้ไดั้ทุกฟัังก์ชั้นั	จึังไม่แนัะนัำ	(ภาพ	1-5	ผู้เขั้ียนัย้าย	Console	pane	จัากล่างซึ้ายมากอยู่บนัขั้วิา	เนัื�องจัาก
เห็นัวิ่าสืะดัวิกมากกว่ิา	โดัยสืามารัถิย้ายไดั้จัาก	เมนัู	View->Panse->Console	on	Rigth)
	 สืำหรัับหนัังสืือนัี�จัะมี	source	code	หรัือ	R	script	ซึึ�งนัักวิิจััยสืามารัถิดัาวินั์โหลดัและนัำเขั้้าหรัือคัดัลอก
แล้วินัำมาวิางในัส่ืวินั	Source	pane	ได้ัเลย	แต่ิอาจัมีการัปรัับแต่ิงเล็กน้ัอย	เช้่นั	การักำหนัดัพื�นัที�ทำงานั	ติำแหน่ัง
ขั้องขั้้อมูล	การันัำเขั้้าเนัื�องจัากสืภาพแวิดัล้อมติ่างกันั	แต่ิสืิ�งเหล่านัี�เป็นัทักษะพื�นัฐานัทั�วิไปขั้องนัักวิิจััยที�มีอยู่แล้วิ

	 2.6	ชุ่ดโปรแกิรม	(Packages)
	 	 2.6.1	ชุ้ดัโปรัแกรัมคืออะไรั
		 	 กล่าวิได้ัวิ่าชุ้ดัโปรัแกรัมคือการัรัวิบรัวิมฟัังก์ช้ันัขั้อง	R	ข้ั้อมูล	และรัวิบรัวิมรัหัสืให้อยู่ในัรูัปแบบที�เขั้้าใจั
ง่าย	ไดัเรักทอรีัที�เรัาจัะเขั้้าถิึงชุ้ดัโปรัแกรัมในัเครัื�องเรัาคือ	library	ซึึ�งสืามารัถิใช้้ฟัังก์ช้ันั	.libPaths()	เพื�อดูัติำแหนั่ง
ขั้องไลบรัารัีขั้องเรัาไดั้	และใช้้ฟัังก์ช้ันั	library()	แสืดังวิ่าชุ้ดัโปรัแกรัมนัั�นัไดั้บันัทึกในัไลบรัารัีขั้องเรัาหรัือยังรัวิมทั�ง
เป็นัการัเรัียกใช้้ชุ้ดัโปรัแกรัมนัั�นัดั้วิย
	 	 RStudio	มีควิามสืามารัถิในัการัวิิเครัาะห์นัอกเหนืัอจัากฟัังก์ชั้นัที�ติิดัติั�งมากับโปรัแกรัมบางครัั�งการั
วิิเครัาะห์ทางสืถิิติิขั้ั�นัสืูงหรัือการัวิิเครัาะห์เฉพาะอย่าง	ฟัังก์ช้ันัที�มีอยู่อาจัไม่สืามารัถิทำไดั้หรัือทำไดั้ไม่ดีั	ไม่ครัอบคลุม
ติามควิามติ้องการัขั้องผู้ใช้้	ซึึ�งกรัณีเช่้นันัี�	ผู้ใช้้	RStudio	สืามารัถิดัาวินั์โหลดัโมดัูล	(modules)	สืำหรัับการัวิิเครัาะห์
ที�สือดัคล้องกับควิามติ้องการัขั้องเรัาไดั้	และนัำมาติิดัติั�งในั	RStudio	ซึึ�งปัจัจัุบันัมีมากกวิ่า	5,5000		โมดูัล	โดัย
เรัียกโมดัูลเหล่านัั�นัวิ่า	ชุ้ดัโปรัแกรัม	(packages)	โดัยดัาวินั์โหลดัไดั้จัาก	http://cran.r-project.org/web/packages
ซึึ�งได้ัจััดัเติรัียมเพื�อเพิ�มขั้ีดัควิามสืามารัถิให้กับ	RStudio	และง่ายไปกว่ิานัั�นั	หากคอมพิวิเติอรั์เรัาเช้ื�อมต่ิอกับ
อินัเทอร์ัเน็ัติ	เพียงแต่ิพิมพ์คำสืั�ง	install.packages	(“				”)	โดัยรัะบุชุ้ดัโปรัแกรัมที�ติ้องการัติิดัติั�ง	หลังจัากนัั�นั
โปรัแกรัมจัะติิดัติั�งให้อัติโนัมัติิ	ซึึ�งจัะกล่าวิเพิ�มเติิมในัหัวิข้ั้อถิัดัไป
	 	 โปรัแกรัม	RStudio	จัะมาพร้ัอมกับชุ้ดัโปรัแกรัมมาติรัฐานั	เช้่นั	base,	datasets,	utils,	grDevices,
graphics,	stats	และ	methods	ส่ืวินัชุ้ดัโปรัแกรัมอื�นัสืามารัถิดัาวิน์ัโหลดัและติิดัติั�งเพิ�มเติิมได้ั	และสืามารัถิใช้้คำสืั�ง
search()	เพื�อติรัวิจัสือบวิ่าชุ้ดัโปรัแกรัมนัั�นัไดั้ติิดัติั�งไวิ้แล้วิหรัือยัง

ภาพ	1-5	คำสืั�งในั	Source	และผลลัพธิ์ที�	Console
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	 	 2.6.2		การัติิดัติั�งและการัเรัียกใช้ชุ้้ดัโปรัแกรัม	
	 	 การัติิดัติั�งชุ้ดัโปรัแกรัม	(installing	a	package)	การัติิดัติั�งชุ้ดัโปรัแกรัมครัั�งแรักใช้้ฟัังก์ช้ันั	install.
package()	เช้่นัถ้ิาเรัาใช้้คำสืั�ง	install.packages()	โดัยไม่กำหนัดัว่ิาจัะติิดัติั�งชุ้ดัโปรัแกรัมใดัผลการัใช้้ฟัังก์ชั้นันัี�
จัะนัำเรัาไปยังเวิ็บไซึติ์ขั้อง	CRAN	mirror	แล้วิเรัาเลือกไซึต์ิที�เรัาติ้องการัดัาวิน์ัโหลดัและติิดัติั�งชุ้ดัโปรัแกรัม	(ไซึต์ินัี�
จัะเกี�ยวิขั้้องกับปรัะเทศ	โดัยปกติิจัะเลือกไซึต์ิที�ใกล้เรัา)		ถิ้าเรัาติ้องการัดัาวิน์ัโหลดัและติิดัติั�งเฉพาะโปรัแกรัม	และ
เรัาทรัาบช้ื�อชุ้ดัโปรัแกรัม		เช้่นั	เรัาติ้องการัติิดัติั�งชุ้ดัโปรัแกรัม	gclus	เรัาสืามารัถิใช้้คำสืั�ง	install.packages(“gclus”)
โปรัแกรัมจัะดัาวิน์ัโหลดั	และติิดัติั�งให้เรัาโดัยอัติโนัมัติิ	เมื�อติิดัติั�งสืำเรั็จั	โปรัแกรัมจัะรัายงานัในัส่ืวินั	Console
พรั้อมกับแสืดังในัสื่วินั	Output	pane	ที�	Package	tap	ดัังภาพ

ภาพ	1-6	การัใช้้คำสืั�ง	search	()	และผลลัพธิ์ที�	Console

ภาพ	1-7	การัติิดัติั�งชุ้ดัโปรัแกรัม	gclus	ดั้วิยคำสืั�ง	install.package()	
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	 	 นัอกจัากใช้้คำสืั�ง	install.packages	()	แล้วิยังสืามารัถิติิดัติั�งจัากแผง	Output	โดัยเลือกโดัยใช้้	Package
tap	และเลือก	install	tap	หลังจัากนัั�นัพิมพ์ชุ้ดัโปรัแกรัมที�ติ้องการัติิดัติั�งลงไปที�ช้่อง	Packages	(separate	with	
space	or	comma)	กรัณีที�ติ้องการัติิดัติั�งหลายชุ้ดัโปรัแกรัมพร้ัอมกันัให้คั�นัด้ัวิยเครัื�องหมายคอมม่า	(,)	หลังจัาก
นัั�นัให้คลิกที�	Install

ภาพ	1-8	การัติิดัติั�งชุ้ดัโปรัแกรัม	gclus	ดั้วิย	install		tap

	 	 ชุ้ดัโปรัแกรัม		(packages)	ที�นัักวิิจััยติิดัติั�งจัะถูิกเก็บไวิ้ในั	Libraries	การัเรีัยกใช้้จัะใช้้ฟัังก์ช้ันั	library	()
เช่้นั	เมื�อนัักวิิจััยติ้องการัใช้้ชุ้ดัปรัแกรัมแกรัม	ggplot2	เขั้ียนัคำสืั�งได้ัวิ่า	library	(ggplot2)	ดัูเพิ�มเติิมในัหัวิขั้้อการัเขั้ียนั
R	script
	 	 2.6.3		การั	update	ชุ้ดัโปรัแกรัม
	 	 เนัื�องจัากชุ้ดัโปรัแกรัมมีการัพัฒนัาอยู่ติลอดัเวิลา	ทำให้เกิดัการัเปลี�ยนัแปลงฟัังก์ช้ันัหรัือคำสืั�งในัชุ้ดั
โปรัแกรัม	รัวิมทั�งเพิ�มเติิมคุณสืมบัติิใหม่	ๆ	(features)	หรืัอยกเลิก	หรืัอเปลี�ยนัแปลงฟัังก์ช้ันั	(คำสืั�งเฉพาะเพื�อให้
โปรัแกรัมปฏิการั	ติามที�นัักวิิจััยต้ิองการั	โดัยภายใต้ิฟัังก์ช้ันันัั�นัจัะมีอัลกอลิทึม	(algolithm)	หรืัอโค้ดัที�เขั้ียนัขั้ึ�นั
ภายใต้ิแนัวิคิดัหรืัอหลักการัอย่างหนัึ�งอย่างใดั	ซึึ�งผู้เขั้ียนัโค้ดัมักจัะอ้างอิงเอาไวิ้ที�สืามารัถิติรัวิจัสือบได้ั	นัักวิิจััยควิรั
มีการั	update	ชุ้ดัโปรัแกรัมอยู่เสืมอ	โดัยที�แผง	Output	ที�		Packages	tap	คลิกที�	Update	tap	หากชุ้ดัโปรัแกรัมใดั
มีการัปรัับปรัุงและพัฒนัาใหม่	เพิ�มเติิมจัะปรัากฏรัายช้ื�อชุ้ดัโปรัแกรัมขั้ึ�นัมา	นัักวิิจััยสืามารัถิเลือกชุ้ดัโปรัแกรัม
ที�ติ้องการั	update	หรัือถิ้าติ้องการั	update	ทั�งหมดัให้เลือก	Select	All	แล้วิคลิก	Install	Updates	
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ภาพ	1-9	การั	update	ชุ้ดัโปรัแกรัม

	 	 2.6.4	ขั้้อมูลและการันัำเขั้้าขั้้อมูล
		 	 นัักวิิจััยสืามารัถินัำเขั้้าขั้้อมูลไดั้สืองวิิธิีคือการัเขั้ียนัคำสืั�งเพื�อนัำเขั้้าขั้้อมูล	แต่ิสืำหรัับมือใหม่ผู้เขั้ียนัขั้อ
แนัะนัำการันัำเขั้้าขั้้อมูลโดัยใช้้เมนัูคำสืั�งที�มีอยู่แล้วิ	ซึึ�งเป็นัวิิธิีการันัำเขั้้าขั้้อมูลเหมือนัการันัำไฟัล์ติ่าง	ๆ	เขั้้าในั
โปรัแกรัมที�เรัาติ้องดัำเนิันัการั	(เช้่นั	นัำไฟัล์	.docx	เขั้้า	MS	Word	หรืัอ	ไฟัล์	.xlsx	เขั้้า	MS	Excel	เป็นัติ้นั)	ตัิวิอย่าง
การันัำเขั้้าข้ั้อมูลบทที�	4	ช้ื�อ	ไฟัล์	incidents_df.csv	ไปที�		Environments	pane	เลือก	Import	Dataset		ให้นัักวิิจััย
เลือกปรัะเภทขั้้อมูลให้ติรังกับขั้้อมูลที�จัะนัำเขั้้า	ในัติัวิอย่างนัี�จัะเลือก	From	Text	(readr)	หลังจัากนัั�นัไปที�	Browse…
เลือกไฟัล์ที�เติรีัยมไวิ้	(ในัโฟัลเดัอร์ัที�เป็นัพื�นัที�ทำงานั)	หลังจัากนัั�นัคลิกที�	Import	ข้ั้อมูลก็จัะพร้ัอมสืำหรัับการัจััดัการั
หรัือวิิเครัาะห์	

ภาพ	1-10	การันัำชุ้ดัขั้้อมูลเขั้้า
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ภาพ	1-11	การันัำชุ้ดัข้ั้อมูลเขั้้าโดัย	Browse	และรัายละเอียดัขั้องชุ้ดัขั้้อมูล

ภาพ	1-12	การัชุ้ดัขั้้อมูลเขั้้าและการัแสืดังข้ั้อมูลในัแผง	Sources

	 	 จัะเห็นัว่ิาในั	Console	pane	จัะปรัากฏคำสืั�ง	และจัะมีเครัื�องหมาย	>	อยู่หน้ัาทุกคำสืั�งเสืมอซึึ�งเป็นั
เช้่นัเดีัยวิกับ	R		นัักวิิจััยสืามารัถิคัดัลอกคำสืั�งไวิ้ในัแผง	Sources	(นัักวิิจััยสืามารัถิ	run	คำสืั�งในัฝัั่�ง	Console	ได้ัแต่ิ
จัะไม่สืะดัวิก)
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	 	 2.6.5	การัเขั้ียนั	การันัำเขั้้าและผลลัพธิ์ขั้อง	R	Script
	 		 การัเขีั้ยนั	R	Script	ก็คือการัเขีั้ยนัคำสืั�ง	หรืัอการัเขีั้ยนัโค้ดั	(coding)	หรัือชุ้ดัคำสืั�ง	เพื�อให้	R	ดัำเนิันัการั
ติามที�นัักวิิจััยต้ิองการั	แต่ิคำสืั�งในัฝัั่�งขั้อง	Sources	pane	จัะเป็นัหมายเลขั้บรัรัทัดัที�คำสืั�งนัั�นัอยู่	ในัหนัังสืือเล่มนัี�
จัะใช้้รัูปแบบคำสืั�งในัรัูปแบบ	Sources	และแสืดังผลลัพธิ์ในัแบบ	Console	pane
		 		 โดัยปกติิเมื�อเรัาเปิดั	R	ขั้ึ�นัมา	จัะเรัิ�มต้ินัด้ัวิยติอนัปัจัจุับันัที�กำลังทำงานั	(interactive	session)	โดัย
การัป้อนัข้ั้อมูลผ่านัแป้นัพิมพ์	และแสืดังผลลัพธิ์บนัหนั้าจัอ	ซึึ�งหมายควิามวิ่านัักวิิจััยติ้องเขั้ียนัคำสืั�งหรัือชุ้ดัคำสืั�ง
โดัยในั	R	จัะเรัียก	Script		ซึึ�งในัการัเขั้ียนั	Script	ใหม่	สืามารัถิเรัิ�มไดั้จัาก	File	->New	File	->	R	Script	หรัือ	กดั
ที�ปุ�ม									ติรังหัวิมุมซึ้ายขั้องเมนูั	แล้วิเลือก	R	script

	 นัักวิิจััยจัะไดั้	Source	ที�วิ่างเปล่าเพื�อรัองรัับการัเขั้ียนั	Script	เช้่นั	ผู้เขั้ียนัต้ิองการัพล็อติ	กรัาฟัเมทรัิกซึ์
สืหสืัมพันัธิ์รัะหวิ่างติัวิแปรั	โดัยใช้้ชุ้ดัขั้้อมูลจัาก	incidents_data.csv	ซึึ�งเก็บในัไดัเรักทอรีั	“/Users/idsaratt/
Documents/Sout	violence”	สืิ�งที�ผู้เขั้ียนัติ้องทำคือนัำเขั้้าขั้้อมูล	เรีัยกใช้้ชุ้ดัโปรัแกรัมในัที�นัี�เรัียกใช้้	readr
package	สืำหรัับอ่านัไฟัล์	.csv	เรัียกใช้้		ggplot2	package	และ	ggstatplot	package	เพื�อสืร้ัางขั้้อมูลภาพ
(visual	data)	และคำนัวิณค่าสืถิิติิ	และกำหนัดัพื�นัทำงานัขั้องโปรัเจักติ์นัี�ดั้วิยคำสืั�ง	setwd	()

ภาพ	1-13	เทียบคำสืั�งแผง	Source	กับ	ผลการั	run	ที�แสืดังในัแผง	Console

ภาพ	1-14	การันัำเข้ั้า	R	Script
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	 แต่ินัักวิิจััยสืามารัถิกำหนัดักรัะบวินัการัขั้องคำสืั�งไดั้จัาก	script	file		หรัือไฟัล์ชุ้ดัคำสืั�ง	หรัือไฟัล์ที�บรัรัจัุ
คำสืั�งขั้อง	R		และกำหนัดัผลลัพธิ์ไปยังปลายทางติ่าง	ๆ	ไดั้ติามที�เรัาติ้องการั	ติัวิอย่างเช้่นั	source	(“myscript.R”)		
		 การันัำเขั้้า	(input)
	 ใช้้ฟัังก์ช้ันั	source	(“filename”)	เพื�อใช้้ชุ้ดัคำสืั�งสืำหรัับการัปรัะมวิลผลในัติอนัปัจัจัุบันั	ถ้ิาไม่ปรัากฏเสื้นัทาง
ขั้องไฟัล์คำสืั�ง	โปรัแกรัมก็จัะเขั้้าใจัว่ิาไฟัล์คำสืั�งนัี�อยู่ในัไดัเรักทอรีัปัจัจุับันั	ตัิวิอย่างคำสืั�ง	source(“myscript.R”)
หมายถิึงการัปรัะมวิลผลคำสืั�งติ่าง	ๆ	ขั้อง	R	ที�อยู่ในัไฟัล์	myscript.R	
	 ผลลัพธ์ิที�เป็นัขั้้อควิาม	(text	output)
		 ใช้้ฟัังก์ช้ันั	sink(“filename”)	เพื�อกลับไปดัูผลลัพธิ์ในัไฟัล์ที�ช้ื�อ	filename	โดัยปกติิถ้ิาไฟัล์นัี�มีอยู่แล้วิ	ไฟัล์เดัิม
จัะถูิกทับด้ัวิยไฟัล์ใหม่	นัอกจัากเรัาใช้้คำสืั�งเพิ�ม	(option)	append=TRUE	เพื�อที�จัะเพิ�มผลลัพธ์ิขั้้อควิามเขั้้าไปในั
ไฟัล์ไดั้ไม่ทับอันัเดัิม	แต่ิถิ้าเรัาใช้้ฟัังก์ชั้นั	sink()	โดัยไม่มีออพช้ันัใดั	ๆ	ผลการัวิิเครัาะห์จัะปรัากฏเฉพาะบนัจัอเท่านัั�นั
	 ผลลัพธ์ิที�เป็นักรัาฟัิก	(graphic	output)
	 การัใช้้ฟัังก์ช้ันั	sink()	จัะมีผลกับผลลัพธิ์ที�เป็นัขั้้อควิามเท่านัั�นั	แติ่ไม่มีผลต่ิอผลลัพธิ์ที�เป็นักรัาฟิักเพื�อกำหนัดั
รัูปและผลลัพธิ์ที�เป็นักรัาฟัิก	เรัาสืามารัถิใช้้ฟัังก์ช้ันัติ่าง	ๆ		ติามที�เรัาติ้องการัให้กรัาฟัิกนัั�นัเป็นัไฟัล์ปรัะเภทใดั	โดัย
ดัูฟัังก์ชั้นัติ่าง	ๆ	ติามติารัาง

ติารัาง	1-1		ฟัังก์ช้ันัการับันัทึกผลลัพธิ์กรัาฟัิก

 ฟังกิ์ช่ันื้	 	 ผิลลัพธ์์

bmp	(“filename.bmp”)	 	 ไฟัล์ช้นัิดั	BMP	
jpeg	(“filename.jpeg”)	 	 ไฟัล์ช้นัิดั	JPEG
pdf	(“filename.pdf”)	 	 ไฟัล์ช้นัิดั	PDF
png(“filename.png”)	 	 ไฟัล์ช้นัิดั	PNG
Postscript	(“filename.ps”)	 ไฟัล์ช้นัิดั	PostScript	file
svg	(“filename.svg”)	 	 ไฟัล์ช้นัิดั	SVG
win.metafile	(“filename.wmf”)	 Window	metafile

	 สืมมติิวิ่าเรัามีไฟัล์คำสืั�ง	R	อยู่	3	ไฟัล์	ไดั้แก่	script1.R,	script2.R	และ	script3.R

> Source(“script1.R”)

	 หมายถึิงการันัำชุ้ดัคำสืั�ง	R		ที�อยู่ในัไฟัล์	script1.R	มาใช้้ปรัะมวิลผลในัรัอบปัจัจัุบันั	(current	session)
และให้ปรัากฏผลในัจัอภาพ	(on	the	screen)	
	 แติ่ถิ้าเรัามีคำสืั�ง	เป็นั

> sink(“myoutput”, append=TRUE, split=TRUE)

> pdf(“mygraphs.pdf”)

> source(“script2.R”)

	 คำสืั�ง	R	จัาก	script2.R	จัะถิูกนัำเสืนัอ	และผลลัพธิ์จัะปรัากฏอีกครัั�งที�จัอภาพ	พรั้อมกับผลการัวิิเครัาะห์ที�
เป็นัข้ั้อควิามเพิ�มเติิมจัากถิูกบันัทึกไว้ิในัไฟัล์	myoutput	และผลลัพธิ์กรัาฟิัก	จัะถูิกบันัทึกไว้ิที�ไฟัล์	mygraph.pdf
	 สืุดัท้ายถิ้าเรัามีคำสืั�งเป็นั
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ภาพ	1-15	การันัำเข้ั้าโดัยฟัังก์ชั้นั	source	()	และผลลัพธิ์โดัยใช้้ฟัังก์ชั้นั	sink	()	

> sink ()

> dev.o! ()

> source (“script3.R”)

	 ชุ้ดัคำสืั�งจัาก		script3.R	จัะถิูกนัำมาใช้้ปรัะมวิลผล	และผลลัพธิ์ที�ไดั้จัะปรัากฏที�จัอภาพ	แติ่ผลการัวิิเครัาะห์
ที�เป็นัขั้้อควิาม	และกรัาฟัิกจัะไม่ถิูกบันัทึกเป็นัไฟัล์	ลำดัับขั้องการัใช้้คำสืั�งสืามารัถิดัูไดั้จัากภาพ	1-15
	 สืำหรัับผู้เขั้ียนัสื่วินัใหญ่ใช้้การัแสืดังผลแบบ	on	screen	กล่าวิคือ	แสืดังผลในั	text		(ติัวิเลขั้ติัวิหนัังสืือติ่าง	ๆ)
ในัแผง	Console	และแสืดังภาพ	หรืัอกรัาฟิักในัแผง	Output	เพรัาะสืามารัถิเห็นัแปรัควิาม	รัวิมทั�งกลับไปแก้ไขั้
เพิ�มเติิมคำสืั�งเพื�อให้ได้ัผลติามที�ติ้องการัได้ัทันัที	แต่ิหากจัะเก็บผลการัปรัะมวิลเอาไว้ิดัูภายหลังจึังใช้้คำสืั�ง	sink	()
สื่วินัการัเก็บรัูปภาพกรัาฟิักข้ั้อมูลภาพ	สืามารัถิสืั�ง	export	จัากแผง	Output	โดัยไม่จัำเป็นัต้ิองเขั้ียนัโค้ดัแติ่ปรัะการัใดั		
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ภาพ	1-16	การับันัทึกขั้้อมูลภาพจัากแผง	Output

	 ติัวิอย่างต้ิองการับันัทึกภาพเพื�อนัำไปใช้้จัากภาพ	1-16	เลือก	Export->เลือกปรัะเภทภาพที�ติ้องการับันัทึก	
ผู้เขั้ียนัเลือก	save		as	PDF	หลังจัากนัั�นักำหนัดัขั้นัาดัภาพ	ลักษณะทิศทางขั้องภาพ	(orientation)	กำหนัดัพื�นัที�
ที�ติ้องการัจััดัเก็บ	(หากนัักวิิจััยกำหนัดัพื�นัที�ทำงานัไวิ้จััดัเก็บในัพื�นัที�ดัังกล่าวิอัติโนัมัติิ)	ติั�งช้ื�อติามที�ติ้องการั	จัะดัูภาพ
ก่อนัให้คลิก	Preview	หรัือจัะบันัทึกโดัยคลิกที�	Save	ซึึ�งไม่ต้ิองเขีั้ยนัโค้ดัใดั	ๆ	
	 	 1.4.3	การัใช้้คำสืั�งในัหนัังสืือสืำหรัับ		RStudio
		 	 เนัื�องจัากในัหนัังสืือนัี�ไดั้แสืดังชุ้ดัคำสืั�งติ่าง		ๆ	สืำหรัับการัวิิเครัาะห์	ซึี�งสืามารัถิดัำเนัินัการัไดั้โดัย
ดัาวินั์โหลดัชุ้ดัคำสืั�งจัากที�ผู้เขั้ียนัไดั้เติรัียมไว้ิ	และนัำเขั้้าในั	RStuio	โดัยไปที�	File	>	Open	File…	เลือกชุ้ดัคำสืั�ง
ที�เติรีัยมไว้ิ	(นัามสืกุล	.R)	อย่างไรัก็ติามในัหนัังสืือเล่มนัี�จัะใช้้วิิธีิการัที�ง่าย	ไม่ซึับซึ้อนัและพยายามใช้้คำสืั�ง	หรืัอ
เขั้ียนัโค้ดัเท่าที�จัำเป็นั	แติ่จัะใช้้การัทำงานัจัากสืภาพแวิดัล้อมที�	RStudio	ได้ัจััดัเติรัียมไวิ้ให้
	 กรัณีคัดัลอกคำสืั�งจัากหนัังสืือไปวิางในัแผง	Sources	สืามารัถิทำไดั้เช้่นัเดัียวิกันั	แติ่ต้ิองปรัับเล็กนั้อยโดัย
นัำเครัื�องหมาย	>	ที�อยู่หนั้าคำสืั�งออก	ดัูภาพ	1-17	
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	 ดั้านับนัเป็นัรัูปแบบคำสืั�ง	และผลลัพธิ์ในัหนัังสืือ	นัักวิิจััยสืามารัถิคัดัลอกคำสืั�งมาวิางในัแผง	Sorces	ติาม
ภาพดั้านัล่างแติ่จัะติ้องนัำเครัื�องหมาย	>	ออก	เนัื�องจัากเครัื�องหมาย	>	ที�อยู่ในัหนัังสืือติิดัมาจัากแผง	Console
และติั�งใจัคงไวิ้เพื�อไม่ให้เกิดัควิามสืับสืนัรัะหวิ่างคำสืั�งกับผลลัพธิ์	โดัยจัะสืั�ง	run	ทีละคำสืั�งหรัือพรั้อมกันัทุกคำสืั�ง
ก็ไดั้	และจัะแสืดังผลในัสื่วินั	Console	อย่างไรัก็ติาม	ผู้เขั้ียนัไดั้เติรัียมชุ้ดัคำสัื�งไวิ้ในัแติ่ละบท	นัักวิิจััยสืามารัถินัำเขั้้า
R	script	ขั้องแติ่ละบท	โดัยกำหนัดัพื�นัที�ทำงานัให้ถิูกต้ิองติามการัจัดััเก็บในัเครัื�องคอมพิวิเติอร์ัขั้องตินัเอง
	 จัากคำสืั�ง
	 บรัรัทัดัที�	1	#	List	1-1	เป็นัการัติั�งช้ื�อคำสืั�ง	โดัยเครัื�องหมาย	#	อยู่ขั้้างหนั้าจัะไม่มีการัปรัะมวิลผลใดั	ๆ
	 บรัรัทัดัที�	2	กำหนัดัพื�นัที�ทำงานั	(ไม่จัำเป็นัแต่ิทำให้สืะดัวิกในัการัทำงานั)
	 บรัรัทัดัที�	3	เรัียกใช้้	read	package	เพื�อนัำเขั้้าไฟัล์ช้้อมูล	.csv	
	 บรัรัทัดัที�	4	นัำเขั้้าขั้้อมูลไฟัล์	missingdata.csv	และเก็บไว้ิในัวิัติถุิช้ื�อวิ่า	missingdata
	 บรัรัทัดัที�	5	แสืดังขั้้อมูลในัแผง	Sources	ดัังภาพ	1-18	
	 บรัรัทัดัที�	6	วิิเครัาะห์ค่าสืถิิติิพื�นัที�ฐานัโดัยสืรัุป	จัะแสืดังผลที�แผง	Console

ภาพ	1-17		รัายการัคำสืั�ง	และผลลัพธิ์จัากหนัังสืือ	และการันัำเขีั้ยนัคำสืั�งในัแผง	Sources	
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	 	 1.4.4	เอกสืารัช้่วิยเหลือ
	 	 ฟัังก์ช้ันั	ชุ้ดัขั้้อมูล	และอ็อบเจั็กต์ิในัติัวิอื�นั	ๆ	ในั	R	จัะถิูกบันัทึกไวิ้ในัรัะบบช่้วิยเหลือ	ค้นัหาแท็บ
“ช้่วิยเหลือ”	ขั้อง	RStudio	เพื�อดัูเอกสืารัเกี�ยวิกับแพ็คเกจั	R	และฟัังก์ช้ันัเฉพาะ	ซึึ�งอยู่ในับานัหนั้าติ่างที�ปรัะกอบ
ดั้วิยไฟัล์	พล็อติ	และแพ็คเกจั	(โดัยปกติิจัะอยู่ในับานัหน้ัาต่ิางด้ัานัล่างขั้วิา)	นัอกจัากนัี�นัักวิิจััยยังสืามารัถิพิมพ์ช้ื�อ
แพ็คเกจัหรัือฟัังก์ช้ันัลงในัคอนัโซึล	R	หลังเครัื�องหมายคำถิามเพื�อเปิดัหนั้าช้่วิยเหลือที�เกี�ยวิขั้้องได้ัอีกดั้วิย	โดัยไม่ใสื่
เครัื�องหมายวิงเล็บ		ตัิวิอย่าง	การัใช้้เอกสืารัช้่วิยเหลือเกี�ยวิกับการัฟัังก์ช้ันั	mean	ดัังภาพ	1-19

ภาพ	1-18	แสืดังขั้้อมูลจัากคำสืั�ง	View	()

ภาพ	1-19		การัใช้้เอกสืารัช้่วิยเหลือเกี�ยวิกับการัฟัังก์ช้ันั	mean
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	 คุณภาพขั้องหนั้าวิิธิีใช้้ขั้อง	R	นัั�นัแติกติ่างกันับ้าง	โดัยสื่วินัใหญ่มักจัะสืั�นัและโครังสืรั้างเหมือนักันัและจัะ
เป็นัปรัะโยช้นั์หากทรัาบวิิธิีอ่านั	ผู้เขั้ียนัไดั้อธิิบายไวิ้ติามภาพ	1-20	จัะให้ภาพรัวิมขั้องสืิ�งที�ติ้องมองหา	โปรัดัจัำไวิ้วิ่า
ฟัังก์ช้ันัจัะรัับอินัพุติ	ดัำเนิันัการั	และส่ืงเอาต์ิพุติ	บางอย่างจัะเขั้้าไป	ดัำเนิันัการัจัากนัั�นัจึังสื่งเอาต์ิพุติออกมา	นัั�นั
หมายควิามวิ่านัักวิิจััยติ้องการัทรัาบวิ่าฟัังก์ช้ันัติ้องการัอะไรั	ทำอะไรัและสื่งคืนัอะไรั	สืิ�งที�ติ้องการัจัะแสืดังในัสื่วินั
การัใช้้งานั	และอาร์ักิวิเมนัต์ิขั้องหน้ัาวิิธีิใช้้	ช้ื�อขั้องอาร์ักิวิเมนัต์ิที�จัำเป็นัและไม่จัำเป็นั	ทั�งหมดัจัะรัะบุติามช้ื�อและ
ติามลำดัับที�ฟัังก์ชั้นัติ้องการั	อารั์กิวิเมนัติ์	บางติัวิมีค่าเรัิ�มติ้นั	ในักรัณีขั้องฟัังก์ช้ันั	mean	()	อาร์ักิวิเมนัต์ิ	na.rm
จัะถิูกติั�งค่าเป็นั	FALSE	ติามค่าเรัิ�มต้ินั	ซึึ�งจัะแสืดังในัสื่วินัการัใช้้งานั	หากอารั์กิวิเมนัต์ิที�มีช้ื�อไม่มีค่าเรัิ�มต้ินั	นัักวิิจััย
จัะติ้องกำหนัดัค่าให้กับอารั์กิวิเมนัติ์นัั�นั	โดัยอารั์กิวิเมนัติ์อาจัเป็นัค่าติรัรักะ	ติัวิเลขั้	ชุ้ดัขั้้อมูล	หรัืออ็อบเจั็กติ์อื�นั	ๆ
ขั้ึ�นัอยู่กับอารั์กิวิเมนัติ์

3.81รเตรียมแลCตร9:สอ7Mอมูล
	 โดัยปกติิแล้วิข้ั้อมูลที�ได้ัมามักเป็นัข้ั้อมูลที�ไม่สืมบูรัณ์	หรืัอมีขั้้อผิดัพลาดั	(Jain	et	al.,2024)	โดัยข้ั้อมูล
ผิดัพลาดั	(missing	data)	อาจัอยู่ในัรูัปขั้องค่าที�สืูงหรืัอติ�ำผิดัปกติิ	(outliers)	หรืัอข้ั้อมูลที�ไม่ถิูกต้ิอง	(wrong

ภาพ	1-20		รัายละเอียดัโครังสืร้ัางขั้องวิิธิีใช้้จัากเอกสืารัช้่วิยเหลือเกี�ยวิกับการัฟัังก์ช้ันั	mean
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data)	บ่อยครัั�งที�นัักวิิจััยมักจัะทำให้เกิดัควิามเสีืยหายกับผลวิิจััยเนัื�องจัากไม่ได้ัมีการัทำข้ั้อมูลให้สืะอาดั		คำว่ิา
ขั้้อมูลสืะอาดั	(clean	data)	จัะหมายถึิงการัติรัวิจัคัดัขั้้อมูล	(screening	data)	เพื�อนัำขั้้อมูลออกในักรัณีที�เป็นั
ขั้้อมูลที�อยู่นัอกพิสืัยขั้องค่าขั้้อมูล	หรัือการัเปลี�ยนัสืภาพขั้้อมูล	(transform)	เพื�อให้เป็นัไปติามขั้้อติกลงเบื�องติ้นั
ขั้องการัวิิเครัาะห์	เมื�อนัักวิิจััยไม่ได้ัทำควิามสืะอาดัข้ั้อมูล	ซึึ�งหมายควิามว่ิาทำการัวิิเครัาะห์ขั้้อมูลด้ัวิยชุ้ดัข้ั้อมูลที�
สืกปรัก	(dirty	data	sets)	ในัสืารันิัพนัธิ์วิิทยานิัพนัธ์ิ	หรัือโครังการัวิิจััย	การัทำควิามสืะอาดัข้ั้อมูลเปรีัยบเสืมือนั
การัทำควิามสืะอาดังานั	แติ่การัทำควิามสืะอาดัขั้้อมูลเป็นังานัที�นัักวิิจััยไม่ค่อยอยากทำถิึงแม้มันัจัะเป็นัสืิ�งสืำคัญ
ก็ติาม	ในัต่ิางปรัะเทศมีค่าจ้ัางในัการัทำควิามสืะอาดัข้ั้อมูลแพง	พอ	ๆ	กับการัจ้ัางวิิเครัาะห์	หรืัอการัแปลควิามหมาย
จัากการัวิิเครัาะห์	หรืัอการัเขีั้ยนัผลการัวิิเครัาะห์	(Pigott,	2001)
	 ขั้้อมูลผิดัพลาดัเป็นัเรัื�องที�เกิดัขั้ึ�นัไดั้โดัยปกติิในัการัวิิเครัาะห์ทางสืถิิติิ	(Little	&	Rubin,	1987)	อัติรัาขั้อง
ขั้้อมูลผิดัปกติินัั�นั	ถิ้านั้อยกว่ิารั้อยละ	1	ถืิอวิ่าไม่มีปัญหาเป็นัขั้้อมูลผิดัพลาดัเล็กนั้อย	ถ้ิาอยู่รัะหว่ิางรั้อยละ	1	–
รั้อยละ	5	ก็ยังสืามารัถิจััดัการัไดั้	แติ่ถิ้าอยู่รัะหวิ่างรั้อยละ	5	-	รั้อยละ	15	จัำเป็นัติ้องแสืดังวิิธิีการัจััดัการัขั้้อมูลให้
เห็นัวิ่าจััดัการัแก้ปัญหาดั้วิยวิิธิีใดั	แติ่ถิ้าเกินัรั้อยละ	15	ขั้ึ�นัไปจัะมีผลติ่อการัติีควิามหมาย		และเกิดัควิามเสืียหาย
ติ่อผลขั้องการัวิิเครัาะห์ขั้้อมูล	(Luengo,	García	&	Herrera,	2012)		ในังานัวิิจััยเป็นัขั้้อมูลที�ปรัะกอบไปด้ัวิย
ขั้้อมูลไม่ถิูกติ้อง	(inaccurate)	ข้ั้อมูลไม่สืมบูรัณ์	(incomplete)	และขั้้อมูลไม่สือดัคล้อง	(inconsistency)	ข้ั้อมูล
เหล่านัี�เป็นัสืาเหติุทำให้การัวิิเครัาะห์ขั้้อมูลเกิดัควิามคลาดัเคลื�อนั	สื่งผลให้การัสืรัุป	และอภิปรัายผลการัวิิจััยไม่ถิูกติ้อง
มีโอกาสืบิดัเบือนัจัากควิามเป็นัจัริัง	เมื�อนัำผลการัวิิจััยไปใช้้อาจัก่อให้เกิดัผลเสีืยหาย	ดัังนัั�นั	ก่อนัการัวิิเครัาะห์ขั้้อมูล
จัึงจัำเป็นัต้ิองมีการัติรัวิจัคัดั	(screening)	และการัทำสืะอาดัขั้้อมูล	(cleaning	data)	ก่อนัเสืมอ
	 นัอกจัากการัติรัวิจัสือบควิามผิดัพลาดัขั้องข้ั้อมูลก่อนัการัวิิเครัาะห์แล้วิ	สิื�งสืำคัญในัการัทดัสือบทางสืถิิติิคือ
การัติรัวิจัสือบขั้้อติกลงเบื�องติ้นั	(assumption)	ในัการัวิิเครัาะห์ขั้องสืถิิติิแติ่ละติัวิที�นัักวิิจััยเลือกใช้้	เพรัาะสืถิิติิ
แติ่ละติัวิมักจัะมีขั้้อติกลงเบื�องติ้นัขั้องการันัำไปใช้้	เนัื�องจัากจัะทำให้สืถิิติินัั�นัมีอำนัาจัในัการัทดัสือบสืูง	ซึึ�งจัะทำให้
ไดั้ผลการัวิิเครัาะห์ที�แม่นัยำ	และมีปรัะสืิทธิิภาพ	ทำให้ไดั้ผลการัวิิจััยที�นั่าเช้ื�อถิือ	สืถิิติิแติ่ละตัิวิ	แติ่ละปรัะเภทจัะมี
ขั้้อติกลงเบื�องติ้นัติ่างกันั	เช้่นั	ในัการัศึกษาเพื�อทดัสือบค่าเฉลี�ยปรัะช้ากรัขั้องแต่ิละทรัีติเมนัต์ิมีค่าเท่ากันัหรัือไม่
หรัือทดัสือบอิทธิิพลขั้องทรัีติเมนัติ์มีนััยสืําคัญหรัือไม่นัั�นั	มีขั้้อติกลงเบื�องติ้นัคือควิามคลาดัเคลื�อนัสืุ่มจัากปรัะช้ากรั
เดัียวิกันัที�มีการัแจักแจังแบบปกติิโดัยมีค่าเฉลี�ยเป็นัศูนัย์	และมีควิามแปรัปรัวินัเท่ากันัในัทุกทรัีติเมนัติ์	และแติ่ละติัวิ
ก็เป็นัอิสืรัะซึึ�งกันัและกันั	หากพบวิ่าขั้้อมูลไม่เป็นัไปติามขั้้อติกลงติามการัทดัสือบพารัาเมติรัิก	(parametric	test)
จัะทําให้ปรัะสิืทธิิภาพขั้องการัทดัสือบลดัลงนํัาไปสืู่การัสืรุัปผลการัวิิเครัาะห์ที�ผิดัพลาดั	และขั้าดัควิามน่ัาเช้ื�อถิือ
ซึึ�งวิิธิีการัแก้ปัญหาในักรัณีที�ขั้้อมูลมีการัแจักแจังแบบไม่ปกติิ	และควิามแปรัปรัวินัมีค่าไม่เท่ากันัสืามารัถิทำไดั้โดัย
การัแปลงขั้้อมูล	(data	transformation)	โดัยใช้้วิิธิีการัทางสืถิิติิ	
	 จัะเห็นัไดั้วิ่าการัติรัวิจัคัดัจัึงเป็นัการัติรัวิจัหาควิามผิดัพลาดัที�เกิดัจัากการันัำเขั้้าขั้้อมูล	ซึึ�งควิามผิดัพลาดันัี�
จัำเป็นัที�จัะมีการัทำควิามสืะอาดัขั้้อมูลเพื�อทำให้ขั้้อมูลสืมบูรัณ์	มีควิามสือดัคล้อง	หรัือมีควิามถิูกติ้องมากที�สืุดัด้ัวิย
ค่าที�เป็นัไปได้ัก่อนันัำไปสืู่กรัะบวินัการัวิิเครัาะห์ขั้้อมูลต่ิอไป	การัทำควิามสืะอาดัข้ั้อมูล	ปรัับปรุังข้ั้อมูลที�เกิดัการั
ผิดัพลาดัให้มีควิามสืมบูรัณ์	ถิูกติ้อง	และสือดัคล้องกันั	มีวิัติถิุปรัะสืงค์เพื�อปรัับรูัปแบบ	(format)	ขั้องค่าในัแต่ิละ
ติัวิอย่างเหมาะสืม	เช้่นั	ข้ั้อควิาม	(string)	ตัิวิเลขั้	(numeric)	การัค้นัหาค่าตัิวิแปรัที�นัอกเหนืัอจัากคู่มือรัหัสืกำหนัดัไวิ้
การัรัวิมหรืัอติัดัขั้้อมูลซึ�ำกันั	ขั้จััดัควิามขัั้ดัแย้งโดัยพิจัารัณาควิามสือดัคล้องภายในัตัิวิแปรั	หรืัอรัะหว่ิางรัะเบียนั
ค้นัหา	และจััดัการัแก้ไขั้ค่าสืุดัโติ่ง	(outliers)	หรัือค่าผิดัพลาดั	(missing	values)	สืำหรัับเทคนัิคการัทำขั้้อมูลให้
สืมบูรัณ์มีดั้วิยกันัหลายวิิธีิ	แต่ิการัจััดัการัข้ั้อมูลผิดัพลาดัจัะต้ิองเป็นัไปด้ัวิยควิามรัะมัดัรัะวัิง	และควิรัแก้ปัญหาโดัย
อาศัยควิามรัู้ที�ถิูกติ้อง	ซึึ�งไดั้มีการันัำเสืนัอผลการัศึกษาเกี�ยวิกับการัแก้ปัญหาในัเอกสืารัที�เกี�ยวิขั้้องจัำนัวินัมาก
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(Acuna	&	Rodriguez,	2004;	Batista	&	Monard,	2003)	ติั�งแต่ิวิิธีิธิรัรัมดัาไปจันัถึิงการัใช้้โปรัแกรัมเขั้้ามาช่้วิย
ในัเนัื�อหานัี�จัะกล่าวิถิึงลักษณะขั้องขั้้อมูลที�ติ้องมีการัจััดัการับางสื่วินัการัแสืดังวิิธิีการัจััดัการัจัากโปรัแกรัม	R	กับ
ขั้้อมูลที�ผิดัพลาดั	และการัทดัสือบขั้้อติกลงเบื�องติ้นัในับางปรัะเด็ันัเท่านัั�นั		

4. )T1SิAIล1A 
		 ค่าผิดัพลาดั	(missing	value)	จัะมีผลต่ิอผลการัวิิเครัาะห์ขั้้อมูล	Luengo	et	al.	(2012)	ได้ัให้คำแนัะนัำ
วิ่า	ค่าผิดัพลาดัจัะมีผลต่ิอการัวิิเครัาะห์ขั้้อมูล	3	ปรัะการัด้ัวิยกันั	คือ	1)	ขั้าดัปรัะสิืทธิิภาพ	(loss	of	efficiency)
2)	มีควิามยุ่งยากติ่อการัวิิเครัาะห์ขั้้อมูล	(complications	in	analysing	the	data)	เนัื�องจัากในัขั้ณะที�มีกรัะบวินัการั
วิิเครัาะห์ขั้้อมูล	ไม่มีวิิธิีใดัแยกไดั้วิ่าขั้้อมูลใดัเป็นัค่าผิดัพลาดั	แติ่ในัควิามเป็นัจัรัิงนัักวิิจััยติ้องแก้ปัญหาค่าผิดัพลาดั
ก่อนัทำการัวิิเครัาะห์ขั้้อมูลจัรัิง	และ	3)	ไดั้ผลการัวิิเครัาะห์ที�ลำเอียงจัากควิามแติกติ่างรัะหวิ่างขั้้อมูลที�มีการัสืูญหาย
และขั้้อมูลที�สืมบูรัณ์	ในัควิามเป็นัจัริังถิึงแม้จัะมีการัแทนัค่าผิดัพลาดัก็ไม่ได้ัผลที�แท้จัรัิงเหมือนัขั้้อมูลที�มีควิามสืมบูรัณ์
ขั้้อมูลที�ผิดัพลาดัไปนัั�นัเป็นัค่าติ่าง	ๆ	ในัการัรัวิบรัวิมขั้้อมูลที�ไม่มีอยู่ดั้วิยสืาเหติุปกติิหรัือผิดัปกติิ	ไม่ถิูกที�	ไม่สืมจัรัิง
หรัือไม่ไดั้รัะบุเลย	ค่าที�ขั้าดัหายไปในัข้ั้อมูลทำให้เกิดัควิามสัืบสืนัทั�งในัการัวิิเครัาะห์ขั้้อมูลและการัยื�นัคำอธิิบาย
สืำหรัับขั้้อมูลใหม่	(Jain	et	al.,2024)	อย่างไรัก็ติามการัวิิเครัาะห์ขั้้อมูลควิรัมีการัติรัวิจัสือบขั้้อมูลที�เป็นัค่าผิดัพลาดั
เสืียก่อนั	ดั้วิยควิามสืำคัญ	และมีผลกรัะทบดัังกล่าวิจัึงมีงานัเขั้ียนัทางดั้านัสืถิิติิวิ่าดั้วิยการัวิิเครัาะห์กรัณีค่าผิดัพลาดั
(Acock,	2005;	Jafrasteh	et	al.,	2023;	Jain	et	al.,	2024;	Ren	et	al.,	2023)

 4.1	ประเภทข้องค่าผิิดพลาด
	 การัพิจัารัณาปรัะเภทขั้องค่าผิดัพลาดัเป็นัขั้ั�นัติอนัที�สืำคัญ	ทั�งนัี�	เพรัาะหากสืามารัถิทรัาบถึิงลักษณะขั้อง
ค่าผิดัพลาดัจัะช่้วิยในัการัพิจัารัณาแนัวิทางสืำหรัับจััดัการักับปัญหาควิามไม่สืมบูรัณ์ขั้องข้ั้อมูลได้ัอย่างเหมาะสืมซึึ�ง	
Salgado	et	al.	(2016)	ได้ัจัำแนักค่าผิดัพลาดัออกเป็นั	3	ปรัะเภทด้ัวิยกันั	คือ	Missing	completely	at	random
(MCAR),	Missing	at	random	(MAR)	และ	Not	missing	at	random	(NMAR)	โดัยในัแติ่ละปรัะเภทมีรัายละเอียดั
ดัังนัี�	(Allison,	2002;	Horton	&	Kleinman,	2007;	Luengo	et	al.,	2011;	Salgado	et	al.,2016)	
	 	 4.1.1	Missing	completely	at	random	(MCAR)
	 	 MCAR		เป็นัลักษณะขั้องค่าผิดัพลาดัที�เกิดัขั้ึ�นัอย่างสืุ่มจัากค่าสัืงเกติทั�งหมดั	นัั�นัคือข้ั้อมูลที�สืูญหาย
เป็นัอิสืรัะจัากตัิวิแปรัต่ิาง	ๆ	สืามารัถิทำการัติรัวิจัสือบลักษณะขั้องค่าผิดัพลาดักลุ่มนัี�โดัยการัแบ่งกลุ่มขั้องค่าสืังเกติ
เป็นักลุ่มข้ั้อมูลปกติิและค่าผิดัพลาดั	ในักรัณีนัี�เมื�อทำการัทดัสือบจัะไม่พบควิามแติกต่ิางอย่างมีนััยสืำคัญรัะหว่ิาง
ทั�งสืองกลุ่มสืำหรัับติัวิแปรัติ่าง	ๆ	ในัชุ้ดัขั้้อมูล	สืำหรัับสืาเหติุที�ทำให้ขั้้อมูลเกิดัการัสืูญหายมีอยู่หลากหลายเหติุผล
อาจัเกิดัขั้ึ�นัเนัื�องจัากเครัื�องมือเสืีย	อุปกรัณ์เกิดัขั้้อบกพรั่อง	สืภาพอากาศเลวิรั้าย	กลุ่มเป้าหมายที�ศึกษาล้มป�วิย
หรัือการันัำเขั้้าขั้้อมูลไม่ถิูกติ้อง	สืำหรัับค่าผิดัพลาดัปรัะเภทนัี�จััดัเป็นัขั้้อมูลที�ก่อให้เกิดัปัญหานั้อยที�สุืดั	เพรัาะวิ่าค่า
ผิดัพลาดัไม่มีควิามเกี�ยวิข้ั้องติ่อผลลัพธิ์ขั้องขั้้อมูล	เพรัาะฉะนัั�นัสืามารัถิเลือกทำการัวิิเครัาะห์ขั้้อมูลในัสื่วินัที�สืมบูรัณ์ไดั้
(Rubin,	1976)	อย่างไรัก็ติาม	Little	(1988)	ไดั้คิดัวิิธิีการัทดัสือบค่าผิดัพลาดัแบบ	MCAR		โดัยใช้้การัทดัสือบ
อัติรัาสื่วินัควิามเป็นัไปไดั้	(likelihood	ratio	test)	เพื�อทำการัทดัสือบขั้้อติกลงเบื�องติ้นัว่ิาด้ัวิย	MCRA	โดัยเรัียกวิ่า
โปรัแกรัม	BMDPAM		โดัยเป็นัสื่วินัหนัึ�งขั้อง	BMDP	(Dixon,	1983)	หรัือใช้้	BaylorEdPsych	package	ทดัสือบ
โดัยมีสืมติิฐานั	H0:	ข้ั้อมูลมีค่าผิดัพลาดัแบบ	MCAR	ซึึ�งมีลักษณะการัแจักแจังแบบไคสืแควิรั์	ถิ้ายอมรัับ	H0		แสืดังวิ่า
ขั้้อมูลมีค่าผิดัพลาดัแบบ	MCAR	แติ่ถิ้าปฏิเสืธิ	H0	แสืดังวิ่าขั้้อมูลมีค่าผิดัพลาดัแบบอื�นัที�ไม่ใช้่	MCRA	
		 	 4.1.2	Missing	at	random	(MAR)
		 	 MAR	เป็นัลักษณะขั้องค่าผิดัพลาดัซึึ�งไม่ไดั้เกิดัขั้ึ�นัอย่างสืุ่มจัากค่าสืังเกติทั�งหมดั	แติ่เกิดัขั้ึ�นัอย่างสืุ่ม
ภายในับางสื่วินั	หรัือบางกลุ่มขั้องค่าสืังเกติ	นัั�นัคือค่าขั้องค่าผิดัพลาดัขั้ึ�นัอยู่กับติัวิแปรัติัวิอื�นั	ๆ	ในัชุ้ดัขั้้อมูลซึึ�งไม่ได้ั
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เป็นัตัิวิแปรัที�เกิดัค่าผิดัพลาดั	ยกตัิวิอย่างเช้่นั	หากพบว่ิาเฉพาะกลุ่มผู้ได้ัรัับการัศึกษาติ�ำที�ไม่ให้ควิามร่ัวิมมือในัการั
ติอบข้ั้อคำถิามเกี�ยวิกับพฤติิกรัรัมการัใช้้สืารัเสืพติิดั	ในัลักษณะนัี�สืามารัถิกล่าวิได้ัวิ่าข้ั้อมูลพฤติิกรัรัมการัใช้้สืารัเสืพติิดั
มีค่าสูืญหายแบบ	MAR	ทั�งนัี�	เนัื�องจัากเป็นัค่าสูืญหายที�เกิดัขั้ึ�นัเฉพาะในับางสื่วินัขั้องตัิวิแปรัรัะดัับการัศึกษา
สืำหรัับค่าผิดัพลาดัปรัะเภทนัี�ยังไม่สื่งผลกรัะทบรัุนัแรังเท่ากับค่าผิดัพลาดัปรัะเภทสุืดัท้าย
			 	 4.1.3	Not	missing	at	random	(NMAR)
						 	 NMAR	เป็นัลักษณะขั้องค่าผิดัพลาดัซึึ�งไม่ไดั้เกิดัขั้ึ�นัอย่างสืุ่ม	โดัยค่าขั้องค่าผิดัพลาดัขั้ึ�นัอยู่กับค่าขั้อง
ขั้้อมูลสืมบูรัณ์ในัตัิวิแปรัเดัียวิกันั	รัวิมถิึงติัวิแปรัติัวิอื�นัดั้วิย	เช้่นั	หากค่าผิดัพลาดัขั้องรัะดัับรัายได้ัขั้ึ�นัอยู่รัะดัับรัายไดั้
ในัแติ่ละช่้วิงอายุ	ค่าผิดัพลาดัที�เกิดัขั้ึ�นัจััดัอยู่ในัปรัะเภท	NMAR	หรัือในับางกรัณีค่าขั้องค่าผิดัพลาดัอาจัไม่ขั้ึ�นัอยู่
กับติัวิแปรัใดั	ๆ	ในัชุ้ดัขั้้อมูลเลย	แต่ิขั้ึ�นัอยู่กับติัวิแปรัอื�นัที�ไม่ได้ัถิูกเก็บรัวิบรัวิมไวิ้ในัการัศึกษาครัั�งนัั�นั	เช้่นั	อัติรัา
การัลดัพฤติิกรัรัมก้าวิรั้าวิขั้ึ�นัอยู่กับพฤติิกรัรัมก้าวิรั้าวิติอนัเรัิ�มติ้นั	แติ่เนัื�องจัากติัวิแปรัพฤติิกรัรัมก้าวิรั้าวิติอนัเรัิ�ม
ติ้นัไม่ไดั้ถิูกรัวิบรัวิมไวิ้ในัฐานัข้ั้อมูลดัังนัั�นั	ค่าสืูญหายขั้องพฤติิกรัรัมก้าวิรั้าวิที�ลดัลงจัึงขั้ึ�นัอยู่กับติัวิแปรัภายนัอก
ขั้้อมูลที�นัักวิิจััยมีอยู่
							 	 	ลักษณะค่าผิดัพลาดัปรัะเภทนัี�จััดัเป็นัค่าผิดัพลาดัที�สืามารัถิสื่งผลกรัะทบอย่างรัุนัแรังในัการัวิิเครัาะห์
ขั้้อมูลในัทางปฏิบัติิ	ลักษณะขั้องค่าผิดัพลาดัปรัะเภท	MCAR	มักพบไม่บ่อยนััก	ที�พบบ่อยครัั�งมักเป็นัค่าผิดัพลาดั
ปรัะเภท	MAR	ดัังนัั�นั	วิิธิีการัทางสืถิิติิติ่าง	ๆ	ที�พัฒนัาขั้ึ�นัมาเพื�อแก้ปัญหาค่าผิดัพลาดั	มักดัำเนิันัการัภายใติ้ขั้้อสืมมติิ
ขั้อง	MAR	เป็นัส่ืวินัใหญ่	(Greiner	et	al.,	1997)

	 4.2	วิธี์กิารจัดกิารกิับัค่าผิิดพลาด	
		 การัจััดัการักับค่าผิดัพลาดัมีหลายวิิธิีการัให้เลือกใช้้	การัพิจัารัณาเลือกใช้้วิิธิีการัใดัขั้ึ�นัอยู่กับลักษณะขั้อง
ค่าผิดัพลาดัที�เกิดัขั้ึ�นั	หากเลือกวิิธิีการัที�ไม่เหมาะสืมมาใช้้อาจัเป็นัการัเพิ�มค่าควิามคลาดัเคลื�อนั	และทำลายผลลัพธิ์
ที�ควิรัจัะได้ั	สืำหรัับวิิธีิการัจััดัการักับค่าผิดัพลาดัมีอยู่ด้ัวิยกันั	3	วิิธีิหลัก	ๆ	ได้ัแก่		1)	การัลบค่าสืูญหายออก
(deletion)	2)	การัแทนัค่าข้ั้อมูล	(imputation)	และ	3)	วิิธีิควิามเป็นัไปได้ัสืูงสุืดั	(maximum	likelihood)	(Li	et	
al.,	2004;	Farhangfar	et	al.,	2008)	เนัื�องในัปัจัจุับันัได้ัมีการัศึกษาวิิธีิการัจััดัการักับค่าผิดัพลาดัเพิ�มขั้ึ�นัจัำนัวินัมาก
ผู้เขีั้ยนัไดั้นัำเสืนัอในับางวิิธีิมีรัายละเอียดั	ดัังนัี�
	 	 4.2.1	การัลบค่าผิดัพลาดั	(deletion)
	 	 1)	Listwise	deletion:	เป็นัวิิธิีการัจััดัการักับค่าผิดัพลาดัที�ง่าย	นัั�นัคือไม่สืนัใจัค่าผิดัพลาดัที�เกิดัขั้ึ�นั
โดัยจัะทำการัวิิเครัาะห์ขั้้อมูลจัากข้ั้อมูลเฉพาะส่ืวินัที�สืมบูรัณ์	แนัวิทางนัี�จัะมีควิามเหมาะสืมในักรัณีที�ค่าผิดัพลาดั
มีจัำนัวินัน้ัอย	ซึึ�งวิิธิีการันัี�มักถิูกกำหนัดัให้ใช้้เป็นัหลัก	(by	default)	สืำหรัับจััดัการักับค่าผิดัพลาดัในัโปรัแกรัม
คอมพิวิเติอรั์ทางสืถิิติิทั�วิ	ๆ	ไป	หากไม่เจัาะจังเลือกใช้้วิิธิีการัอื�นัในัการัจััดัการักับค่าผิดัพลาดั	ในัการัใช้้	Listwise
deletion	สืามารัถิใช้้ไดั้ดัีในักรัณีค่าผิดัพลาดัแบบ	NMAR	และสืามารัถิใช้้ไดั้ในัขั้้อมูลแบบ	MCAR	แติ่อาจัมีปัญหา
เมื�อใช้้กับ	MAR	ถ้ิาขั้้อมูลมีลักษณะแบบ	MAR	อาจัทำให้มีการัปรัะมาณค่าที�ลำเอียง	เช้่นั	กรัณีนัักวิิจััยติ้องการั
ปรัะมาณค่าเฉลี�ยรัายได้ัจัากปรัะช้ากรั	โดัยร้ัอยละ	80	รัายงานัรัายได้ัเป็นัเพศหญิง	และมีเพียงร้ัอยละ	60	ขั้องเพศช้าย
ที�รัายงานั	(ลักษณะนัี�เป็นัการัละเมิดัแบบ	MCAR)	แติ่ภายในัแติ่ละกลุ่มขั้องเพศที�ผิดัพลาดัที�มีผลติ่อรัายไดั้ไม่ไดั้
ขั้ึ�นัอยู่กับรัายไดั้	(MAR)	สืมมติิฐานัในักลุ่มเพศช้ายเกี�ยวิกับค่าเฉลี�ยคืออาจัสืูงกวิ่าเพศหญิง	วิิธิีการั	Listwise	deletion
จัะทำให้ลดัควิามลำเอียงในัการัปรัะมาณค่าเฉลี�ยรัายไดั้โดัยรัวิมในัปรัะช้ากรั	(Allison,	2009)	การัใช้้	Listwise
deletion	จัะมีควิามแกร่ังเมื�อมีการัละเมิดั	MCAR	(หรืัอ	MAR)	สืำหรัับตัิวิแปรัทำนัายในัการัวิิเครัาะห์ถิดัถิอย	โดัย
เฉพาะอย่างยิ�งเมื�อค่าสืูญหายขั้องติัวิแปรัทำนัายไม่ไดั้ขั้ึ�นักับติัวิแปรัติาม	การัใช้้	Listwise	deletion	จัะทำให้ไดั้ค่า
การัปรัะมาณไม่ลำเอียงในัค่าสืัมปรัะสืิทธิิ�ถิดัถิอย	(Little,	1992)	และเทคนัิคนัี�ยังเหมาะกับการัวิิเครัาะห์ถิดัถิอย
แบบอื�นั	ๆ	เช้่นั	linear,	logistic,	Poisson	หรัือ	Cox	regression	(Allison,	2009)
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	 	 2)	Pairwise	deletion:	เป็นัวิิธิีการัจััดัการักับค่าผิดัพลาดัสืำหรัับกรัณีที�ทำการัวิิเครัาะห์ควิามสืัมพันัธิ์
รัะหวิ่างคู่ตัิวิแปรั	โดัยจัะทำการัลบข้ั้อมูลในัส่ืวินัที�เป็นัค่าสืูญหายขั้องทั�งสืองตัิวิแปรัทิ�งและจัะทำการัวิิเครัาะห์ขั้้อมูล
จัากขั้้อมูลสื่วินัที�มีค่าสืมบูรัณ์ทั�งสืองติัวิแปรั	วิิธิี	Pairwise	deletion	เป็นัวิิธิีที�ไดั้รัับควิามนัิยมมาก	โดัยเฉพาะเมื�อ
นัำมาใช้้กับการัวิิเครัาะห์โมเดัลเช้ิงเสื้นั	(linear	model)	แบบติ่าง	ๆ	เช้่นั	การัวิิเครัาะห์ถิดัถิอย	หรัือการัวิิเครัาะห์
โมเดัลสืมการัโครังสืร้ัาง	(structural	equation	modeling)	เหมาะกับการัปรัะมาณพารัามิเติอร์ัที�หลากหลาย
เช่้นั	ค่าเฉลี�ย	ควิามแปรัปรัวินั	หรืัอ	ควิามแปรัปรัวินัร่ัวิม	รัวิมทั�งค่าสืหสืัมพันัธิ์	เมื�อขั้้อมูลมีลักษณะแบบ	MCAR
วิิธิีการั	Pairwise	deletion	จัะให้ค่าปรัะมาณที�ไม่ลำเอียง	(Kang,	2013)		เช้่นัเดัียวิกับวิิธีิ	Listwise	deletion
ถิ้าขั้้อมูลมีลักษณะแบบ	MAR	แต่ิไม่เป็นัแบบ	MCAR	การัปรัะมาณพารัามิเติอร์ัอาจัให้ค่าปรัะมาณที�ลำเอียง	วิิธีิ
Pairwise	deletion	โดัยปกติิแล้วิจัะยังคงให้ปรัะสิืทธิิภาพมากกว่ิาวิิธิี	Listwise	deletion	เนัื�องจัากจัะได้ัขั้้อมูล
มากกวิ่าในัการัปรัะมาณค่า	อย่างไรัก็ติามนัักวิิจััยอาจัไม่สืามารัถิวิิเครัาะห์ขั้้อมูลไดั้	เนัื�องจัากอาจัเกิดัปัญหาการั
ไม่สืามารัถิรัะบุควิามเป็นัไปไดั้ในัทางบวิก	(not	a	definite	positive)	และไม่สืามารัถิ	inverted	เพื�อปรัะมาณ
พารัามิเติอร์ัไดั้	ปัญหาดัังกล่าวิทำให้เป็นัการัยากที�จัะได้ัค่าควิามคลาดัเคลื�อนัมาติรัฐานัที�แม่นัยำ	เนัื�องจัากค่าควิาม
แปรัปรัวินัร่ัวิมหรัือค่าสืหสืัมพันัธิ์จัะถูิกปรัะมาณจัากขั้นัาดัติัวิอย่างที�แติกติ่างกันั	(Van	Praag	et	al.,1985)	
	 	 4.2.2	การัแทนัค่า	(imputation)
	 	 1)	Mean	substitution:	เป็นัวิิธีิการัแทนัค่าผิดัพลาดัด้ัวิยค่าเฉลี�ยขั้องตัิวิแปรันัั�นัมาแทนัค่าสูืญหาย
(Kantardzic,	2003)	การัแทนัค่าที�เรัียกวิ่า	imputation	คือการันัำค่าเฉลี�ยขั้องติัวิอย่างนัั�นัมาแทนัค่าสืูญหาย	ถิ้า
ติัวิอย่างในักลุ่มใดัก็แทนัค่าด้ัวิยคะแนันัเฉลี�ยขั้องกลุม่นัั�นั	ซึึ�งเป็นัวิิธิีที�พัฒนัามาจัากการัแทนัค่าค่าผิดัพลาดัด้ัวิยค่าเฉลี�ย
ขั้องขั้้อมูลที�ทรัาบค่า		ทั�งนัี�	เนัื�องจัากข้ั้อสืมมติิฐานัที�วิ่าค่าขั้องค่าผิดัพลาดัควิรัจัะต้ิองขั้ึ�นัอยู่กับลักษณะขั้องหน่ัวิย
ติัวิอย่าง	โดัยลักษณะขั้องหนั่วิยติัวิอย่างที�ใกล้เคียงกันัควิรัจัะมีค่าขั้้อมูลที�สืนัใจัคล้ายคลึงกันั	แติ่ผลที�ติามมาคือจัะ
ทำให้ค่าเบี�ยงเบนัมาติรัฐานัลดัลง	วิิธิีนัี�จัะทำให้ไดั้ค่าปรัะมาณที�ลำเอียง	(Haitovsky,	1968)	
	 	 2)		Regression	method:		ทำการัสืรั้างสืมการัถิดัถิอยรัะหวิ่างติัวิแปรัใดั	ๆ	ที�ติ้องการัจัากขั้้อมูลที�
สืมบูรัณ์	โดัยกำหนัดัให้ติัวิแปรัติามเป็นัตัิวิแปรัที�มีขั้้อมูลไม่สืมบูรัณ์	จัากนัั�นัใช้้สืมการัถิดัถิอยที�ได้ัทำการัปรัะมาณ
ค่าขั้องขั้้อมูลที�ไม่สืมบูรัณ์	วิิธิีนัี�เป็นัวิิธิีการัแทนัค่าแบบหนึั�งแติ่ให้ค่าปรัะมาณค่าที�ดัีกวิ่าแทนัค่าดั้วิยค่าเฉลี�ย	(Allison,
2002;	Chen	&	Chang,	2024;	Hernández-Herrera	et	al.,	2024)	
			 	 3)	Hot	deck	imputation:	เป็นัวิิธีิการัพิจัารัณาเลือกหนั่วิยติัวิอย่างที�มีลักษณะคล้ายคลึงกันัมากที�สุืดั
กับหนั่วิยติัวิอย่างที�เกิดัค่าสืูญหาย	จัากนัั�นัแทนัค่าที�สูืญหายด้ัวิยค่าขั้องหน่ัวิยติัวิอย่างที�คล้ายคลึงนัั�นั	(Andridge	&	
Little,	2010;	Wang	et	al.,	2022)
			 	 4)	Multiple	imputation	(MI):	เป็นัวิิธิีการัที�ผสืมผสืานัรัะหวิ่างวิิธิีการั	EM	และ	Raw	maximum
likelihood	methods	รั่วิมกับควิามสืามารัถิขั้องนัักวิิจััยสืมบัติิ	hot	deck	เพื�อทำการัสืรั้างชุ้ดัจัำลองขั้องขั้้อมูล
ที�ไดั้ทำการัแทนัค่าค่าผิดัพลาดัดั้วิย	imputed	value	แล้วิขั้ึ�นัมาหลาย	ๆ	ชุ้ดั	(ปรัะมาณ	5-10	ชุ้ดั)	จัากนัั�นัจัะทำ
การัวิิเครัาะห์ขั้้อมูลจัากชุ้ดัต่ิาง	ๆ	บันัทึกผลการัวิิเครัาะห์ที�ไดั้เหล่านัี�จัะถิูกรัวิมเขั้้าด้ัวิยกันั	ปัญหาที�พบในัการัใช้้วิิธิีการั
แทนัค่า	คือ	ค่าควิามคลาดัเคลื�อนัมาติรัฐานัไดั้ค่าปรัะมาณที�ติ�ำกวิ่าควิามเป็นัจัรัิง	ทำให้ไดั้ค่าสืถิิติิที�มีค่าสืูงและไดั้
ค่านััยสืำคัญทางสืถิิติิที�ติ�ำเกินัไป	(อ่านัเพิ�มเติิมไดั้จัาก	Madley-Dowd	et	al.,	2019;	Pedersen	et	al.,	2017;
Wang	et	al.,	2022;	Woods	et	al.,	2024)
	 	 2.2.3	วิธิิีควิามเป็นัไปไดั้สืูงสืุดั	(maximum	likelihood)
	 	 1)	Expectation	Maximization	(EM)	approach:	วิิธีิการันัี�เป็นัการัอาศัยหลักขั้องกรัะบวินัการัวินัซึ�ำ
(iterative	procedure)	รัะหวิ่าง	2	ขั้ั�นัติอนั	โดัยขั้ั�นัติอนัแรัก	เป็นัขั้ั�นัติอนัที�เรัียกวิ่า	Expectation	(E)	step	ซึึ�งจัะ
ทำการัปรัะมาณค่าคาดัหวัิงจัากฟัังก์ช้ันั	likelihood	ภายใต้ิขั้้อมูลที�สืมบูรัณ์	สืำหรัับขัั้�นัติอนัที�สือง	เป็นัขัั้�นัติอนัที�
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เรัียกวิ่า	Maximization	(M)	step	เพื�อทำการัแทนัค่าคาดัหวิังขั้องค่าผิดัพลาดัด้ัวิยค่าที�ไดั้จัาก	E	step	และทำการั
ปรัะมาณค่าคาดัหวิังจัากฟัังก์ชั้นั	likelihood	ในักรัณีถิ้าไม่เกิดัค่าผิดัพลาดั	โดัยจัะทำการัทวินัซึ�ำ	รัะหวิ่าง	2	ขั้ั�นั
ติอนัจันักว่ิาจัะเกิดัค่าที�ลู่เขั้้า	(convergence)	หรืัอค่าที�มีการัเปลี�ยนัแปลงน้ัอยมาก	ใช้้ค่านัั�นัแทนัค่าค่าผิดัพลาดัที�เกิดัขั้ึ�นั
	 	 2)	Raw	maximum	likelihood	methods:	เป็นัวิิธิีการัที�อาศัยข้ั้อมูลสืมบูรัณ์ในัการัสืรั้างค่า	maximum
likelihood	ภายใต้ิติัวิแบบทางสืถิิติิที�เหมาะสืม	ไม่วิ่าจัะเป็นัโมเดัลสืมการัโครังสืร้ัาง	โมเดัลถิดัถิอย		ANOVA	หรืัอ
ANCOVA	วิธิิีนัี�เหมาะกับกรัณีค่าผิดัพลาดัแบบ	NMAR
	 	 ผลที�อาจัเป็นัไปไดั้ในัการัจััดัการัค่าผิดัพลาดัต่ิอการัปรัะมาณพารัามิเติอร์ั	มีดัังนัี�	1)	กรัณีที�ขั้้อมูลมีค่า
สืูญหายแบบ	MCAR	การัลบติัวิอย่างออกไปจัะเป็นัวิิธิีการัที�ง่ายที�สืุดั	และมีปรัะมาณค่าอย่างไม่ลำเอียง	2)	ถิ้าขั้้อมูล
เป็นัแบบ	MAR	ใช้้วิิธิีการัทดัแทนัขั้้อมูล	ยังเป็นัวิิธิีการัปรัะมาณค่าแบบไม่ลำเอียง	และ	3)	ถิ้าขั้้อมูลเป็นัแบบ	MNAR

การัปรัะมาณค่าแบบไม่ลำเอียงเป็นัสืิ�งที�เป็นัไปไม่ได้ั	แติ่วิิธิีการัแก้ไขั้แบบใหม่	ๆ	ในั
ปัจัจุับันั	จัะช้่วิยลดัการัลำเอียงในัการัปรัะมาณค่า
	 นัักวิิจััยสืามารัถิติรัวิจัสือบค่าผิดัพลาดั	และจััดัการัไดั้ดั้วิยโปรัแกรัมทางสืถิิติิ
ติัวิอย่างที�ใช้้เป็นัขั้้อมูลปรัะกอบดั้วิยติัวิแปรั	Y	X1	X2	X3	ข้ั้อมูลที�ไดั้จัากตัิวิอย่าง
156	คนั	โดัยติรัวิจัสือบและจััดัการัด้ัวิยโปรัแกรัม	Rิเมื�อติรัวิจัสือบค่าสืถิิติิพื�นัฐานัได้ั
ค่า	ดัังนัี�	(download	ขั้้อมูลและคำสืั�งจัาก	QR	code)

รัายการั	1-1	คำสืั�งและผลลัพธิ์การัติรัวิจัค่าสืถิิติิพื�นัฐานั

> setwd(“/Users/idsaratt/Documents/Book Resoruces/Lesson 1”)
> library(readr)
> missingdata <- read_csv(“missingdata.csv”)
> View(missingdata)
> summary(missingdata)
   Y                  X1                X2                X3       
 Min.    :   1.00    Min. :  7.0    Min.    :  1.700    Min.    :  57.00  
 1st Qu. :  18.00    1st Qu. :  115.8    1st Qu. :  7.400    1st Qu. :  73.00  
 Median  :  31.50    Median  :  205.0   Median :  9.700    Median  :  79.00  
 Mean    :  42.13    Mean    :  185.9    Mean    :  9.806    Mean    :  78.28  
 3rd Qu. :  63.25    3rd Qu. :  258.8    3rd Qu. :  11.500    3rd Qu. :  85.00  
 Max.    :  168.00    Max.    :  334.0    Max.    :  20.700    Max.    :  97.00  
 NA’s    :  37        NA’s    :  7        NA’s    :  7         NA’s    :  5     

	 จัากข้ั้อมูลจัะพบว่ิาตัิวิแปรั	Y	X1	X2	และ	X3	มีค่าผิดัพลาดั	(ดูั	NA’s)	โดัยเฉพาะ	Y	มีค่าผิดัพลาดัถึิง	37	
ค่า	X1	และ	X2	ตัิวิแปรัละ	7	ค่า	สื่วินั	X3	มีจัำนัวินั	5	ค่า	รัวิมค่าผิดัพลาดัทั�งหมดั	55	ค่า	เห็นัไดั้วิ่าส่ืวินัใหญ่ค่า
ผิดัพลาดัมาจัากตัิวิแปรั	Y	โดัยทั�วิไปถ้ิาพบว่ิา	ค่าผิดัพลาดัเป็นัแบบ	MCAR	มากเกินัไปอาจัเป็นัปัญหาได้ัเช้่นักันั
โดัยปกติิเกณฑิ์สืูงสืุดัที�ปลอดัภัย	คือ	ไม่เกินัรั้อยละ	5	ขั้องจัำนัวินัทั�งหมดัสืำหรัับชุ้ดัขั้้อมูลขั้นัาดัใหญ่	หากขั้้อมูลที�
ขั้าดัหายไปสืำหรัับบางตัิวิอย่างเกินัร้ัอยละ	5	อาจัจัะนัำตัิวิอย่างนัั�นัออกจัากการัวิิเครัาะห์	ดัังนัั�นั	นัักวิิจััยจึังติรัวิจัสือบ
นัักวิิจััยสืมบัติิ	(คอลัมนั์)	และติัวิอย่าง	(แถิวิ)	ซึึ�งขั้้อมูลมากกวิ่ารั้อยละ	5	หายไปโดัยใช้้ฟัังก์ชั้นัง่าย	ๆ

รัายการั	1-2	คำสืั�งและผลลัพธิ์การัติรัวิจัสือบค่าผิดัพลาดัเบื�องต้ินั

> is.na(missingdata)
           Y    X1 X2 X3
  [1,] FALSE  FALSE FALSE TRUE
   [2,]  FALSE  FALSE  FALSE   TRUE
    [3,]  FALSE  FALSE  FALSE   TRUE
    [4,]  FALSE  FALSE   TRUE   TRUE
   [5,]   TRUE   TRUE   TRUE   TRUE
    [6,]  FALSE   TRUE   TRUE  FALSE
   [7,]  FALSE  FALSE   TRUE  FALSE
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   [8,]  FALSE  FALSE   TRUE  FALSE
   [9,]  FALSE  FALSE   TRUE  FALSE
   [10,]   TRUE  FALSE   TRUE  FALSE
   . . .
  [142,] FALSE  FALSE  FALSE  FALSE
  [143,]  FALSE  FALSE  FALSE  FALSE
  [144,]  FALSE  FALSE  FALSE  FALSE
  [145,]  FALSE  FALSE  FALSE  FALSE
  [146,] FALSE  FALSE  FALSE  FALSE
  [147,]  FALSE  FALSE  FALSE FALSE
  [148,]  FALSE  FALSE  FALSE  FALSE
  [149,]  FALSE  FALSE  FALSE  FALSE
  [150,]   TRUE  FALSE  FALSE  FALSE
  [151,]  FALSE  FALSE  FALSE  FALSE
  [152,]  FALSE  FALSE  FALSE  FALSE
  [153,]  FALSE  FALSE  FALSE  FALSE 

	 เมื�อใช้้คำสืั�งติามรัายการัจัะเป็นัการัถิามวิ่าค่าสืังเกติใดัที�มีค่าผิดัพลาดั	ถิ้า	FALSE	หมายถิึง	ไม่ใช้่ค่าผิดัพลาดั
แต่ิถิ้าติอบ	TRUE	หมายถึิง	เป็นัค่าผิดัพลาดั	เช้่นั	ตัิวิแปรั	Y	ค่าสืังเกติที�มีค่าผิดัพลาดัค่าแรัก	คือค่าสืังเกติที�	5	

รัายการั	1-3	คำสืั�งและผลลัพธิ์การัติรัวิจัสือบรั้อยละค่าผิดัพลาดั

 > library(lattice)
 > pMiss <- function(x){sum(is.na(x))/length(x)*100}
 > apply(missingdat,2,pMiss)
   Y X1 X2 X3 
   24.183007 4.575163 4.575163 3.267974 

 > apply(missingdata,1,pMiss)
  1]     25 25 25 50 100 50 25 25 25 50 25 0 0 0 0 0 0
  [18 0 0 0 0 0 0 0 25 25 50 0 0 0 0 25 25 25
  [35] 25 25 25 0 25 0 0 25 25 0 25 25 0 0 0 0 0
  [52] 25 25 25 25 25 25 25 25 25 25 0 0 0 25 0 0 0
  [69] 0 0 0 25 0 0 25 0 0 0 0 0 0 0 25 25 0
  [86] 0 0 0 0 0 0 0 0 0 0 25 25 25 0 0 0 25
  [103] 25 0 0 0 25 0 0 0 0 0 0 0 25 0 0 0 25
  [120] 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0
  [137] 0 0 0 0 0 0 0 0 0 0 0 0 0 25 0 0 0

	 จัากข้ั้อมูลจัะพบว่ิา	ติัวิอย่างที�มีค่าผิดัพลาดัมากที�สืุดั	คือ	ตัิวิอย่างที�	5	โดัยมีค่าผิดัพลาดั	ตัิวิแปรัจัาก	4	ตัิวิแปรั
คิดัเป็นัร้ัอยละ	100	รัองลงมาเป็นัตัิวิอย่างที�	4	6	10	และ	27	มีค่าผิดัพลาดัร้ัอยละ	50	คือ	มีค่าผิดัพลาดั	2	ในั	4	ตัิวิแปรั
สื่วินัที�เหลือที�เกิดัค่าผิดัพลาดัเกิดัจัากตัิวิแปรัเดีัยวิ	หรืัออยู่ที�รั้อยละ	25	นัักวิิจััยทำให้ค่าผิดัพลาดันัี�มีค่ารั้อยละลดัลง
ไดั้โดัยการัเก็บขั้้อมูลเพิ�มเติิม	หรัือทำให้ลดัลงโดัยหลักการัทางสืถิิติิดัังไดั้กล่าวิไปแล้วิ	สื่วินัตัิวิอย่างอื�นัที�ติ�ำกวิ่า
เกณฑิ์รั้อยละ	5	นัักวิิจััยสืามารัถิเก็บไวิ้เพื�อนัำไปวิิเครัาะห์ขั้้อมูล	แติ่จัากขั้้อมูลพบวิ่า	บางติัวิอย่างที�มีค่าผิดัพลาดั
ค่อนัข้ั้างมาก	(รั้อยละ	50	ขั้ึ�นัไป)	เช่้นั	ตัิวิอย่างที�	4	5	6	10	และ	28	ควิรันัำออกจัากการัวิิเครัาะห์ขั้้อมูลถ้ิาเป็นัไปไดั้
และไม่มีผลกรัะทบติ่อขั้นัาดัติัวิอย่างในัการัวิิเครัาะห์มากนััก
	 นัักวิิจััยสืามารัถิติรัวิจัสือบแบบแผนัขั้องค่าผิดัผลาดัไดั้จัาก	mice	package	ดัังนัี�


